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About Datgel CPT Tool  2.2 
The Datgel CPT Tool gINT Add-In 2.2 is designed to streamline the processing and interpretation of 
Cone Penetration Test and Dissipation Test data: 

¶ Designed for flexibility and user configuration 

¶ ASCII data files in numerous standard and propriety formats may be imported 

¶ Filter rod changes 

¶ Calculate derived parameters 

¶ The soil type and strength may be interpreted based on user defined parameters, and then a 
summary can be transferred to your soil description and consistency/density table 

¶ More than 65 preconfigured published correlations are calculated, written to the database and 
ready for presentation on your graphs and logs 

¶ User-definable correlation formulas 

¶ Dissipation test analysis 

¶ More than 200 customisable log, graph and fence reports 

¶ User definable line colours, types and scales 

¶ Our CPT processing code has been used to manage tens of thousands of tests by clients 
across the globe 

You need to complete the installation procedure (see Installation and Licensing on page 1) and activate 
(see Datgel Product Licensing System User Guide) before you can use the CPT Tool. 

New in Version 2.2  

1. User definable units, allowing for the use of English units 

2. Correlations for hydraulic conductivity 

3. Soil behaviour types correlations by Eslami Fellenius (1997), Ramsey (2002), and 
Schmertmann (1978) 

4. Non-normalized Soil Behaviour Type Index, ISBT, Robertson (2010) 

5. Database schema restructure of project and point level parameters 

6. Log and fence report speed improvement 

7. Support for AGS 4 

8. Control minimum thickness of a SBT layer 

9. Import of more data file formats: Vertek (*.ecp) and Datem Neptune (*.cdf) 

10. Support for gINT Professional Plus with SQL Server 

11. Multi-threaded calculation 

12. Data correction tool 

New in Version 2  

1. More than 60 preconfigured correlations  

2. Formula Tool for user-definable correlation formulas 

3. Dynamic user definable log, fence and graph reports 
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4. User definable line colours, types and scales 

5. Schneider, Randolph, Mayne and Ramsey (2008) soil behaviour type interpretation 

6. Dissipation test analysis 

7. Import of more data file formats: Vertek (*.dat), Pagani (*.cpt), Geomil PlotCPT (*.T*) 

8. Seismic cone presentation 

Versions Used When Writing This Document  

This user guide has been written using: 

¶ CPT Tool gINT Files 2.20 

¶ CPT Tool DLL 2.2.3 

¶ gINT Professional Plus 8.30.03.52 

¶ Windows 7 64 bit operating system 

Support  

12 months support and maintenance is included with the license purchase.  For technical support 
please email support@datgel.com or call +61 2 8202 8600. 

System Requirements  

gINT 

The product runs optimally using gINT 8.2.008 or higher, however it will run using gINT 8.1.2.008 or 
higher. 

gINT Professional or gINT Professional Plus is recommended.  The product will run using gINT Logs, 
gINT Professional or gINT Professional Plus.  However the tool includes graph and fence reports that 
can only be used with gINT Professional and gINT Professional Plus. 

Hardware and Operating System 

Same system requirements as gINT 8.2, see: http://www.gintsoftware.com/products_requirements.html. 

Required Windows Components 

1. Windows Installer 3.1 

2. .NET 3.5 Framework SP1 

Conventions and typography used in this guide  

Note: Tips and additional Information to help you. 

> Used to indicate a series of menu commands. 

e.g. Select File > Open.  

| Used to indicate a gINT Application Group, Application, Table Group or Table , e.g. 
DATA DESIGN | Project Database 

Bold Text Items you must select, command buttons, or items in a list. 

e.g. Navigate to UTILITIES | Convert Projects (4
th

 tab). 

mailto:support@datgel.com
http://www.gintsoftware.com/products_requirements.html
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Italics Emphasis Use to emphasize the importance of a point such as parameters. 

e.g. Data Entry ï Check Omit Must Save prompt when save is required 

CAPITALS Names of keys on the keyboard. for example, SHIFT, CTRL, or ALT. 

KEY+KEY Key combinations, for example CTRL+P, or ALT+F4. 

Code Snippet  Indicates a code snippet within a paragraph 

Code sample  Indicates a sample program codes inserted in user guide e.g. 

public override string ToString ()  

File name  or path  Used for formatting file name and paths e.g. di_lib.g lb  or  

V: \ 10 gINT \ Datgel Install Files \  

Table_Name Database table name, e.g. POINT_TABLE. 

Field_Name Database field name; e.g. PointID 

Command line Command line, presented exactly as it must be entered e.g. 

Cdir 

Field Colours  

Each of the fields in the project tables have been coloured to improve the data entry process as 
indicated below in Table 1. 

Table 1 - Field Colours  

Field Colour  Field Name and Explanation  

 Yellow gINT Key Field ï mandatory data entry 

 Pastel Purple 
AGS Data ï data associated with the AGS Data 
Interchange format 

 Pastel Green 
Calculated Field ï data is written to this field by Datgelôs 
code 

 Brown - Green Data Enter and Calculated field 

 Pastel Beige 
Data Entry Field ï data should be entered into this field, 
or data in this field influences the calculation 

 Pastel Red 
Legacy Data Field ï historic data entered here, is from 
typically an old database 

 Pastel Blue 
Output Option ï used to control how the data displayed 
on a report 

 Pastel Orange 
Remark or Metadata Field ï additional data associated 
with the primary information 

 Grey Read-only 

 

Note: The Datgel CPT Tool is supplied with three versions database options ï DGD SI metric with long 
table (e.g. CPT_POINT_PARAMETERS) and field names, DGD EN same names as DGD SI but with 
English/Imperial units, and AGS RTA with short AGS RTA-compliant names (e.g. STCS). 
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Both names are usually given, although only one is relevant to any given site. Screen images are not 
duplicated and usually show only the DGD SI version. 
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1 Ins tallation and Licensing  

If youôre trialling the CPT Tool, then please first work through the following sections: 1.1 DLL Program 
Installation, 1.2 Which Database Structure? ï DGD SI, DGD EN or AGS RTA, and 2 Quick Start 
Tutorial.  Please also watch the CPT Tool video on datgel.com. 

There are four parts to the installation process: 

¶ DLL program installation 

¶ Merge gINT library objects 

¶ Merging project tables and fields 

¶ Configure settings in library and project/data template 

¶ Activate the product license 

The first three steps can be completed in any order and are described below. The activation procedure 
must be done last and is described in the Datgel Product Licensing System User Guide. 

1.1 DLL Program Installation  

The CPT Tool requires that the Microsoft .net 3.5 framework is installed on the PC prior to the 
installation of the CPT Tool.  If your PC does not have the .net 3.5 framework SP1 installed, then it will 
be automatically installed during the CPT Tool installation process.  You need local administrator rights 
to the PC to install the CPT Tool.  

To install the CPT Tool: 

¶ Ensure that gINT is closed 

¶ Run the setup.exe file 

¶ Follow the prompts 

In the following screen, you can either accept the default location for the new file, or change it by 
clicking Browse. The Disk Cost button shows the space required versus space available on each of 
your disks.  
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1.2 Which Database Structu re? ï DGD SI, DGD EN or AGS RTA  

At this point you must decide which CPT Tool database structure to use.  The options are: 

1. DGD SI stands for Datgel Database with SI/metric units and long table (e.g. 
CPT_POINT_PARAMETERS) and field names. 

2. DGD EN stands for Datgel Database with English/Imperial units and long table (e.g. 
CPT_POINT_PARAMETERS) and field names. 

3. AGS RTA, based on the structure prescribed by the Roads and Traffic Authority of NSW, 
Australia, and the Association of Geotechnical and Geoenvironmental Specialists.   The 
database has short AGS RTA-compliant names (e.g. STCS).  This option uses metric/SI units. 

Unless youôre currently using an AGS RTA style database, we recommend you adopt the DGD 
database most relevant for your local practice. 

1.3 Merge gINT Library Objects  

Note: If youôre in one of the following situations then proceed to Section 1.6 Validate or Activate 
License. 

In the trial version of the CPT Tool, the library will be locked and you cannot merge any gINT Library 
Objects into your Library file, or make changes to this Library file.  In this case, you have to use the 
locked library as-is.   

Steps 1.3 to 1.5 have been done by Datgelôs developers or done previously by you or a colleague. 

If you donôt have existing gINT files then you may wish to just use the example CPT Tool gINT Files 
provided on the DVD. 

If you have purchased the CPT Tool, then you have full access to the library objects, and you may 
proceed with the following steps to merge the gINT Library components into your Library file.  

1. Make a backup copy of your existing library file. By default this is located at: 

C: \ Users \ Public \ Documents \ Bentley \ gINT \ libraries \  

2. Start gINT and open the library and project file you wish to use the Datgel CPT Tool with. 
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3. If have existing library tables with the same name as those in the CPT Tool files, please now 
delete those tables.  To do this, go to DATA DESIGN | Library Tables > File > Listé, select 
the rows to delete, and press the Delete key.   

4. If you have an older version of the CPT Tool in your gINT files, it is simpler to delete the library 
objects prior to merging the new version.  This is done by navigating to each library application, 
e.g. Log Blocks, displaying the List of objects, and deleting those starting with DG CPT. 

5. Select UTILITIES | Lib Merge/Copy. 

6. Browse the Source Library File for datgel  cpt  tool  dgd  lib  #. ## <Unit> .glb  

7. Check the Query On Overwrite box, then move all source tables, except Material Composite 
Symbols and Tiles, to the yellow box on the right side by clicking the >> button. 

 

8. Click Execute.  The process may take several minutes. 

This merges the CPT Tool Add-In menu item, gINT Rules modules, user system data and other library 
tables relevant for the use of the CPT Tool. 

Depending on which page sizes you tend to use, you may find it convenient to not merge the Letter 
(LET) and 11x17 or the A4 and A3 reports. 

1.4 Merge gINT Project File Tables and Fields  

1. Open your existing project/data template in DATA DESIGN | Project Database. 
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2. If you have existing tables for CPT data or old tables for the CPT Tool, you should delete them 

now.  A simple way to delete multiple tables is to call Tables > Listé or , select the tables 

to delete, click the delete key, and click OK. 

3. Select Tables > Import Multiple Tables...  then browse for either file datgel cpt  tool  

dgd  #. ## <unit> .gpj or datgel cpt  tool  dgd  #.##  <unit> .gdt .    
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4. At the minimum, select the following tables to import, and click OK.   

The select blue rows are required.  The tables indicated by red boxes are used by reports and 

should be merged if your project doesnôt have existing equivalent tables.  The rest of the tables 

are generally ItemKey tables and are used as lookup lists by fields. 

a) DGD 
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b) AGS RTA 

 
 

5. Merge fields from POINT.  Change the object selector to POINT, and call Tables > Merge fields 

from other fileé, select datgel cpt  tool  dgd  #.## <unit>.gpj or datgel cpt  

tool  dgd  #.## <unit>.gdt , then select POINT, and select the fields to merge.  We 

suggest if youôre unsure, merge them all and reconcile them later. 

6. Merge fields from PROJECT.  Follow a similar process to that for POINT. 

7. Consider report changes to suite your custom project database. 

Many of the gINT reports provided with the CPT Tool reference the red boxed tables, and you 
may need to update the field references in the reports to work with your custom project 
database.  In particular you need to consider fields on the POINT and PROJECT tables. 

The DATA DESIGN | Project Database | Tools > Compare Databases function will list the 
table, field, and property differences between databases.  Use this to compare your companyôs 
project file to the CPT Tool project file. 

The DATA DESIGN | Project Database | Tools > Replace Field Names function will assist 
you to update the CPT library objects to use the fields and tables in your custom project file. 

8. In DATA DESIGN | Project Database change the yellow object selector list to the POINT table, 
call the command Tables > Properties... move to the gINT Rules tab, and place Datgel Cpt 
Tool!OnSave in the gINT Rules Procedure on Save text box. 
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9. Move to INPUT, and run the Add-Ins > Datgel Administrator Tools > Lookup List Check 
Tool to search for broken lookup list references, and rectify as needed.  This step requires the 
Datgel Administrator Tools to be installed and licensed. 

1.5 Initial Configuration  

Following the library and project merge steps, the following items should be configured: 

1. Move to INPUT and reorder the tables within the CPT table group.  Select CPT Group, and call 
Tables > Input Sequenceé 

a) DGD 

 

b) AGS RTA 

 

2. Configure the Graphic_1 and Graphic_2 fields on DG_CPT_SOIL_CLASS_ZONES library table; see 
4.15 DG_CPT_SOIL_CLASS_ZONES on page 25.  Select the most appropriate graphics in 
your library for each soil type zone. 

3. Configure the table and field names for Lithology/Stratigraphy and Consistency/Density as 
described in 16.3 Configuration of description and consistency summary transfer on page 88 . 

4. In SYMBOL DESIGN | Bitmap Symbols, import your company logo into the existing symbol 
called LOGO.  This symbol is referenced by all the Tools reports.   

Alternatively you can adjust the DRAWINGS | Drawing Library DG COM LOGO to reference 
a different Bitmap Symbols. 

Review how your logo appears on the DRAWINGS | Drawing Library block DG COM FIGURE 
TITLE BLOCK.  If required change the block x and y offset. 
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5. Update the import correspondence files (*.gci) for the numerous CPT formats to work with your 
custom gINT project file.  Particularly the POINT and PROJECT tables. 

6. Assign correct page sizes and printer to reports.  In order to export a report to pdf or other 
image format the correct page size must be assigned. 

a) Ensure a printer driver installed on your pc has A3 and 11x17 size. 
b) Use the command REPORT DESIGN | File > Set printer for reports, pick the printer with 

A3 from the printer list, and select the A3 size reports from the reports list. 
c) Then go to each A3 and 11x17 size report in REPORT DESIGN by changing the yellow 

drop down list.  Display the report properties, File > Page > Properties, and set the page 
size to A3 or 11x17. You may also need to adjust the margins. Click Ok. 

d) Review the page margins and outlines by clicking on Zoom Page, and move to the next 
report. 

1.6 Validate or Activate License  

After installation (and before using the CPT Tool Add-in), validate or activate the user license as 
described in Chapter 2 of the Datgel Product Licensing System User Guide. 
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2 Quick Start  Tutorial  

2.1 Introduct ion  

This tutorial will introduce you to the basic operations of the CPT Tool; it assumes you have a basic 
understanding of gINT INPUT and OUTPUT.  If this is the first time youôve used gINT then we suggest 

you read the welcome_to_gint_8.pdf  located in this directory C: \ Program Files  

(x86) \ Bentley \ gINT \ docs  and also available from this web page 

http://www.gintsoftware.com/support_doc.html. 

2.2 Preliminaries  

1. First work your way through sections 1.1 DLL Program Installation and 1.2 Which Database 
Structure? ï DGD SI, DGD EN or AGS RTA. 

2. Start gINT 8, and check youôre running 8.2.008 or 8.1.2.008 or later by reviewing the version 
number on the Help > About gINT dialog.  If youôre running an older update, then you should 
download and install the latest gINT version from Bentleyôs SELECT website or the trial page 
on datgel.com. 

3. This tutorial will use our standard DGD SI CPT Tool gINT Files, located on the DVD in folder 

gINT Files \ DGD SI \ .  If you havenôt done so, copy the folders on the DVD to a location on 

your local or network drives.  You can also use a set of custom gINT files that already have the 
CPT Tool tables and objects merged in, as described in section 1 Installation and Licensing. 

4. Now, open the datgel cpt tool dgd lib X.XX  SI .glb , using File > Change Library. 

5. Create a new project, select the command File > New Project > Clone Data Template..., and 

select the datgel cp t tool dgd X.XX  SI .gdt  file, and click Open.  Then provide the 

name Tutorial 1.gpj  and click Save. 

2.3 Importing CPT and Dissipation Data  

1. Launch the Data Import Tool, by calling the command Add-Ins > Datgel CPT Tool > Data 
Import. 

 

The CPT Tool splash screen should now appear, signifying you are now using the CPT Tool 
license.   

¶ If youôre using a trial license then a form will appear telling you how many uses are left.   

¶ If nothing happens, then double check you have installed the CPT Tool program by 

running the setup.exe  file located in the I nstallation Files  folder on the DVD. 

¶ If you havenôt previously validated your license, i.e. by entering the serial number, license 
number, contact details, and server name in the case of a network license.  Then you will 

http://www.gintsoftware.com/support_doc.html
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be prompted to do so now, and you should refer to Chapter 2 of the Datgel Product 

Licensing System User Guide, which was included on the DVD in the Documentation  

folder. 
 

You should now see the Data Import Tool form. 

 

2. In this tutorial we will import GEF files.  

a) Set File Type to GEF 1.1.0 (*.gef) 
b) Set Overwrite Option to Never 

c) Set Correspondence File to é\ datgel_cpt_tool_dgd_ si_ X.XX_gef _XX.gci .  The 

gci can be found in the gINT Files \ DGD SI \  folder on the DVD.  The gci file translates 

the data during the import process between a temporary CSV file created by the CPT Tool 
code and the DGD database tables and fields. 
 

Select the Browseé button in the top right of the form, and browse to the \ Example CPT 

Data Files \  folder from the DVD.  Select: "GEF_01.GEF" "GEF_01_D01.GEF" 

"GEF_01_D02.GEF" .  The *D* files are dissipation test files related to the GEF_01.GEF 

file.  The form should now look similar to the screenshot (apart from the folder paths). 

 

 

d) Click Execute.  There will be a short pause while the Datgel code translates the data, then 
you will see a gINT progress form.   
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Finally when the import is complete a gINT Import Log form will display. 
 

 
 
It can be useful to review the Source and Target record counts to confirm the data has 
imported.  The Log also lists overwrite and lookup warnings.  In this case the warnings are 
of little consequence. 
 
You may now like to step through the tables in the project file, and observe the imported 
data.  Note that some values, such as those on the Project Parameters table are default values 
stored in the data template file we used to make the new project. 

2.4 Configuring Parameters and CPT Data Analysis  

The following information must be entered for the basic CPT Calculations to occur: 

¶ CPT Data - Upper: Test Number, Cone ID, and (optionally) Groundwater Depth 

¶ CPT Data - Lower: Depth, qc, fs, u2 (for CPTu) 

¶ Cone Information: Cone ID, Cone Area Ratio (for CPTu), Cone Sleeve Offset (used to filter rod change 
noise for fs), and Cone Diameter (used by dissipation test analysis) 
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¶ Point Parameters: (optionally) Groundwater Depth 

¶ Project Parameters: Most fields should be set, and these will be used as default values.  In 
particular to enable basic calculations you should define: 

¶ Bulk Unit Weight 

¶ Bulk Unit Weight Saturated 

¶ Soil Class Method 1 

¶ Soil Class Method 2 

Refer to section 7 Groundwater and Overwater Testing for a detailed explanation of where to set 
groundwater data. 

When you change the value of related fields the CPT Tool table calculation will automatically initiate.  
You can suppress the automatic calculation by checking Suppress Automatic Calculation on Project Parameters, 
and the calculation can be run later as part of a batch calculation (for more information see section 9 
Initiation of the CPT Data Calculation). 

The resulting CPT Data screen should look like this: 

 

2.5 Transfer Summary of Material Description  

We will now transfer a summary of the soil layers to the Strata Main table.  Call the command Add-Ins > 
Datgel CPT Tool > Transfer Description and Consistency for current PointID, then move to Main 
Group | Strata Main to see the transferred descriptions.  You can edit the description data, and it will 
not be over written unless you call the Add-In command again. 

2.6 Output a Log  

To produce a log output click on the OUTPUT tab. 

From the Logs tab, select the Report CPTU SU DR A3L, and the PointID GEF_01.  Then click preview, 
and you should see this: 
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2.7 More Information  

Refer to section 20 Dissipation Test Analysis for a tutorial on that subject. 
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3 Project Tables  
The test and interpreted data is stored in the project database.   

A number of constants and assumptions are required in derivations.  Many may be set at a project level 
on Project Parameters and Project Correlation Parameters, for each PointID on Point Parameters and Point Correlation 
Parameters, by depth for a PointID on Point Material Properties and some for each push (on CPT Data ï Upper).  
This gives the user full control on which level in the hierarchy to use.  

3.1 POINT 

When an Elevation is changed the Tool will calculate.  The PointID and HoleDepth fields must be defined. 

3.2 CPT Data ï Upper (CPT_GENERAL or STCG)  

This table defines each CPT stroke within a PointID, since under some circumstances multiple CPT 
strokes take place in the same hole.  Each stroke has a unique Test Number.   

 

3.3 CPT Data ï Lower (CPT_DATA or STCT)  

This table stores the actual raw depth related data for each push and derived results related to each 
reading. 

3.4 Dissipation Test (CPT_DISSIPATION_TEST_GENERAL and 

CPT_DISSIPATION_TEST_READINGS, STDG and STDS)  

These tables store the Dissipation Test raw and derived data.   
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3.5 BPT Data (CPT_BPT_GENERAL & CPT_BPT_DATA)  

Spherical Ball Penetrometer Data is stored on these tables.  In future versions correlations will be 
added. 
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3.6 Cone Information - Upper (CPT_CONE_INFORMATION or STCI)  

The cone and equipment constants are stored on this table.  For example, two important constants are 
the Cone Area Ratio and Cone Sleeve Offset. 

 

3.7 Cone Information - Lower (CPT_Cone_Calibration or STCC) 

This table can be used to record the calibration dates for each cone. 

3.8 Point Parameters - Upper (CPT_POINT_PARAMETERS)  

This table stores the Point level constants and assumption values related to derived parameters and 
soil behaviour type calculations.  Hence if you wish to set the groundwater depth for all strokes for a 
PointID then that value should be entered into the Groundwater_Depth field on the CPT_POINT_PARAMETERS 
Table. 
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3.9 Point Correlation Parameters - Upper 
(CPT_POINT_CORRELATION_PARAMETERS)  

Point level constants for correlations are stored in this table. 
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3.10 Point Correlation Parameters - Lowe r 

(CPT_POINT_MATERIAL_PROPERTIES ) 

A bulk unit weight, e, Nk, Nkt depth profile may be defined for each PointID on the 
CPT_POINT_MATERIAL_PROPERTIES table.  The depth ranges for a particular PointID must not overlap in 
any way. You will not be able to save the table if overlapping depth ranges are entered. 

3.11 Project Parameters (CPT_ PROJECT_PARAMETERS) 

Project level constants and parameters related to derived parameter and soil behaviour type 
calculations are stored on this table.   

 

3.12 Project Correlation Parameters 

(CPT_PROJECT_CORRELATION_PARAMETERS)  

Project level correlation parameters and constants are stored on this table.   
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3.13 Project Output Options (CPT_PROJECT_OUTPUT_OPTIONS)  

This table stores the project level report output options. 

 

3.14 Point Symbology (CPT_POINT_SYMBOLOGY)  

This table stores Point level overrides for the settings on CPT_PROJECT_SYMBOLOGY and 
DG_CPT_SYMBOLOGY. 
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3.15 Project  Symbology (CPT_ PROJECT_SYMBOLOGY)  

This table stores Project level overrides for the settings on DG_CPT_SYMBOLOGY.  You can set scales, 
line types etc. for each parameter here for the entire project. 
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3.16 Correlation Summary (CPT_CORELATION_SUMMARY)  

This table was added to support AGS 4 Format.  Currently users must manually enter summary data in 
this table.  If there is a demand Datgel could develop a function to automatically populate this table. 

 

3.17 Design Line (CPT_DESIGN_LINE and 

CPT_DESIGN_LINE_DATA)  

These tables define the design line for Cone Resistance and all correlations.  In the case of Cone 
Resistance the data is written to the CPT Data table, and can display on log and fence reports.  For 
correlations the data is optionally displayed on Graph reports, and not written to CPT Data.  You can 
assign the Design Line to use on the Project Parameter and Point Parameter tables. 
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3.18 Formula Configuration (CPT_FORMULA_CONFIGURATION)  

This is a hidden table, and stores Project level formulas. 

3.19 Data Correction Configuration  
(CPT_DATA_CORRECTION_FORMULA_CONFIG)  

This is a hidden table and stores Project level Data Correction formulas. 
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4 Library Tables  
This section lists library tables that are important to calculation of the CPT Tool and reports. 

4.1 DG_COM_UNIT_CONVERSION 

This table contains a list of the units, conversion factors and equations, and is referenced to convert 
values from one unit to another throughout the CPT Tool. 

4.2 DG_CPT_AUTO_FILTER 

This table is a simple lookup for the filter options. 

4.3 DG_CPT_DATA_CORRECTION_FORMULA_CONFIG  

This table stores Library level data correction formulas. 

4.4 DG_CPT_DEPTH_ELEVATION_SCALE  

Attribute table used by log reports. 

4.5 DG_CPT_FENCE_BLOCK  

Lookup and attribute table used by Fence reports. 

4.6 DG_CPT_FIELD_MAP 

Stores the table and field name configuration used by the CPT Tool calculation.  This allows the user to 
set non-standard field and table names.  If a parameter is missing the DGD name is used as default. 

This table also stores units, field rules and default values used for Unit Conversion for each unit system. 

4.7 DG_CPT_FORMULA_CONFIGURATION  

These table stores Library level formulas for the Formula Tool. 

4.8 DG_CPT_LOG_BLOCK  

Lookup and attribute table used by dynamic log reports. 

4.9 DG_CPT_MEASUREMENT_SYSTEM 

This table is a simple lookup for the measurement system type options, based on the GEF standard. 

4.10 DG_CPT_MODIFIED_TIME_FACTOR 

Used for dissipation analysis 

4.11 DG_CPT_PORE_PRESSURE_FILTER_POSITION 

Used for dissipation analysis 
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4.12 DG_CPT_SCALE_TYPE 

This table is a simple lookup for the soil classification graph type options. 

4.13 DG_CPT_SOIL_CLASS_DATA  

This table stores the soil classification polygon data.  Users can add their own classification methods. 

 

4.14 DG_CPT_SOIL_CLASS_METHOD  

This table stores the names and graphing options for each soil classification method. 
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4.15 DG_CPT_SOIL_CLASS_ZONES  

This table stores the descriptions and graphics for each soil classification zone. 

 

4.16 DG_CPT_SOIL_TYPE 

This table is a simple lookup for the soil type options. 



 

 

CPT Tool gINT Add-In 2.2  Datgel 
User Guide 26 DCT-UG-001 - 2.12.2 - November 2011 
 

4.17 DG_CPT_SYMBOLOGY 

This table stores the library defaults for line colour and types etc.  The field references are used by 
reports and should not be altered. 

4.18 DG_CPT_SYMBOLOGY_SCALES_UNITS  

Stores parameter scales for each Unit System. 

4.19 DG_CPT_TERMINATION 

This table is a simple lookup of reasons for terminating a CPT stroke, based on the GEF standard. 

4.20 DG_CPT_TEST_METHOD 

List of test standards. 

4.21 DG_CPT_TRANSFER_SUMMARY_DESC_CONSISTENCY 

This table stores the target table and field names soil description and consistency data summary 
transfer. 

4.22 DG_CPT_TYPE 

List of AGS Format CPT Types. 

4.23 DG_CPT_ZERO_LOCATION 

This table is a simple lookup for zero location. 

4.24 DG_LOG_CONSISTENCY_DENSITY 

This table stores the soil consistency and relative density terms and ranges. These are used to 
calculate the fields Relative_Density_Term_# and Undrained_Shear_Strength_Term_# on CPT_DATA table. 
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CPT Tool gINT Add-In 2.2  Datgel 
User Guide 28 DCT-UG-001 - 2.12.2 - November 2011 
 

5 Data Import  
The Data Import Tool allows you to import data from various file formats into gINT.  The command is 
located in INPUT Add-Ins > Datgel CPT Tool > Data Import. 

 

On load the default setting will populate the form.  In addition, the previous correspondence file used for 
each file type be loaded as default. 

5.1 Tools Menu  

¶ Load Defaults: Loads all selections, field values and the initial directory that has been 

previously saved as default. 

¶ Save Defaults: Saves defaults for File Browse Type, Friction Sleeve Offset, and Overwrite 

Option.  

¶ Set Initial Directory: Sets the initial browse directory so that every time you browse, it will start 

at the set directory. 

¶ About: Displays the version information of the Data Import Tool. 

5.2 File Browse Types  

¶ Individual Files: Select one or more files in a single folder manually. 

¶ Folder: Select a folder and all relevant files in that folder are selected automatically. 

¶ Folder and Sub-Folders: Select a folder and all relevant files in that folder and its sub-folders 

are selected automatically. 

Files paths may be manually entered or deleted from the large text box. 

5.3 File Types  

¶ A.P. van den Berg Gorilla! (*.* ) ï CPT and Dissipation 

¶ Access database files (*.gpj; *.mdb) 
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¶ AGS (*.ags )  

¶ Datem Neptune (*.cdf)  

¶ Delimited Depth qc fs u (*.* ) ï simple file with no header, and data delimited by tab, ",", ";", or 

":".  The u data is not required, and the columns must be in the order Depth qc fs u.  The file 

name (without the extension) will be used as the PointID. 

¶ Douglas Partners (*.* ) 

¶ GEF 1.1.0 (*.gef ) ï CPT and Dissipation.  The friction shift is applied for 1.0.0 version files 

only 

See: http://www.geonet.nl/index.html?http&&&www.geonet.nl/3.020.html 

¶ Geomil PlotCPT (*.T*) 

¶ gINT CSV (*.csv ; *.txt ) ï regular gINT compliant csv file. 

¶ gINT Excel (*.xls ) ï regular gINT compliant excel file. 

¶ Gregg Drilling (*. cor ) 

¶ Hogentogler (*.cpd) 

¶ Pagani (*.cpt) 

¶ Pagani (*.dat) 

¶ ProbeDrill (*.txt ; *.dis ) ï you must import *.txt  and *.dis  files together.  The *.dis  file 

and *.txt  file for the one location MUST has the same file name 

¶ Swedish Geotechnical Format (SGF) and Geotech AB (*.cpt ; *.dpt ; *.ini )  

See: http://www.sgf.net/home/page.asp?sid=862&mid=2&PageId=21095 

¶ Vertek (*. ecp ) 

5.4 Overwrite  Option  

These are the standard gINT overwrite options. 

5.5 Correspondence File  

gINT correspondence files need to be developed or altered to meet the needs of each companies gINT 
project database for each data source file type.  We have provided example files that meet the needs of 
Datgelôs standard project files. 

5.6 Create Temp Import F ile 

During the import process the initial data files are read and transferred to a temporary file in gINT 
compatible CSV format.  If this box is checked, the Data Import Tool will bring up a new window 
showing the contents of this temporary file, and will not continue with the import.  This can be saved as 
a CSV, and used as the source when designing an import correspondence file. 

http://www.geonet.nl/index.html?http&&&www.geonet.nl/3.020.html
http://www.sgf.net/home/page.asp?sid=862&mid=2&PageId=21095
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In this interface, click Save As to save the text as a file, or Print to print the text on a printer. You must 
save the text as a file before you can modify the text. This file can be imported into gINT with the Data 
Import Tool with gINT CSV selected as the File Type. 

5.7 Importing Multiple Strokes /Tests into one PointID  

The Depths in all strokes within the one PointID must have the same zero depth reference, hence if 
multiple strokes are done down a borehole, then when importing the Depth field must be populated with 
pre-drill Depth plus the push depth.  This can be achieved in the correspondence file if the predrill depth 
in recoded in the source data file. 

Gorilla files are a common offshore data file format, and we have seen files with the start depth of each 

test recorded in fields titled Reference Level  and Depth Borehole . 

[TEST]  

<GORILLA! he ader>  

job number=BH - CPTU- S8- BL 

client=PETRONAS CARIGALI  

job description=SEPAT 8 LOCATION  

.  

.  

.  

operator=ZAHID/HILMI  

reference level=3.0  

reference point=M.S.L  

pre drilled=0.0  

GORILLA! - remark 1=  

.  

.  

.  

GORILLA! serie #=  

<user header>  

NORM=KTN/PCSB/08/268/SI  

START DEPTH= 

Seabed ref level=  

Seabed ref point=  

Depth borehole=3.0  
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Vanedepth=  

 

[SCALING FACTORS]  

.  

.  

.  

[DATA]  

*D: 0.02 #1:0.01#2:0.000#4:4#0:28!  

*D:0.04#1:0.01#2:0.000#4:4#0:29!  

*D:0.06#1:0.03#2:0.000#4:3#0:30!  

*D:0.08#1:0.04#2:0.001#4:4#0:31!  

*D:0.10#1:0.0 5#2:0.001#4:4#0:32!  

Gorilla File Example with relevant depth information highlighted 

Two correspondence files read the start depth from the different fields and calculate the true depth of 
each reading below the borehole reference level (typically seabed). 

¶ datgel_cpt_tool_dgd_2.01_gorilla_cpt_Depth_Borehole_##.gci  

¶ datgel_cpt_tool_dgd_2.01_gorilla_cpt_Reference_Level_##.gci  

After importing a set of test files for one PointID, you will need to manually set the POINT.HoleDepth field 
with the correct maximum depth of the test. 

5.8 Importing only the File Name from the Full File Path  

If the full file path of the source file is being imported, but you only want to import the file name, you can 
modify the gINT correspondence file (.gci) to extract the file name from the full file path to import into 
gINT. 

Open the gINT correspondence file in a text editor, and then search for the field name where the file 
path is being directed to (for example, File_Reference). Replace the existing expression with the 
following: 

<<GetListItem <<Original Expression>> ," \ ",<<ListCount (<<Original Expression>> )>>," \ ")>>)>>  

Where <<Original Expression>>  is the original expression that retrieves the full file path for that 

particular field. 
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6 CPT Filter  
The tool can filter out rod change noise for ή and Ὢ. The filter algorithm works based on Penetration_Rate 
(mm/s), and if it is not in the data file, then it is calculated based on elapsed time. You can set the 
Filter_Threshold_Penetration_Rate on the CPT_PROJECT_PARAMETERS and CPT_POINT_PARAMETERS, or use 
the default of 6 mm/s. If you manually run the filter then the threshold rate increases 1 mm/s each run 
per CPT push, i.e. the applied threshold rate = Filter_Threshold_Penetration_Rate + Filter_Count 

Data is only filtered if it is less than 95% of the mean of the previous two values, and the third and 
fourth values ahead. 

In order for the Ὢ filtering to take place, the Cone_Sleeve_Offset on the CPT_CONE_INFORMATION table must 
be defined. 

If the Auto_Filter_Calculation on the CPT_PROJECT_PARAMETERS or CPT_POINT_PARAMETERS tables is set to 
Automatic (whichever is lower in the hierarchy with data), then the Filter will run once on import and set 
the Filter_Count field on the CPT_GENERAL table to ñ1ò.  If Filter_Count field on the CPT_GENERAL table is set 
to less than ñ1ò or null, the filter will run On Save. 

The filter may be run manually more times using the command INPUT | Add-Ins > Datgel CPT Tool > 
CPT Filter.  However the cursor must be in the bottom half of the CPT_DATA table. 
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7 Groundwater  and Overwater Testing  

7.1 Groundwater Depth for Standard Onshore Testing  

The ground water depth is critical to many derived results, and can be defined in a number of ways.  In 
order of priority: 

1. CPT_GENERAL table, Groundwater_Depth field 

2. CPT_POINT_PARAMETERS table, Groundwater_Depth field 

3. CPT_PROJECT_PARAMETERS table, Groundwater_Depth field 

4. CPT_PROJECT_PARAMETERS table, Groundwater_Elevation field 

 

In the CPT_PROJECT_PARAMETERS table, the Water_Density_Field field is also required, and should be set 
appropriately for fresh or salt water. 

On the CPT_GENERAL table define: 

¶ CPT_GENERAL.Water_Depth: Nothing 

¶ CPT_GENERAL.Zero_Location: S ï Surface or Nothing 

¶ CPT_GENERAL.Pre_drilled_Depth: Nothing or value as required, doesnôt influence calculation 

¶ CPT_GENERAL.Groundwater_Depth: Distance from ground level (0 depth) to the groundwater 
surface, or use Groundwater_Depth fields on other tables listed above 

 

In situ pore pressure is calculated relative to the atmospheric pressure using the following formula: 

 ὍὪ ᾀ ᾀ ὸὬὩὲ ό π 

ὍὪ  ᾀ ᾀ ὸὬὩὲ ό ᾀ  ᾀ  Ͻ‎ 

Where: 

ᾀ is the depth below the reference level 

ᾀ  is the groundwater depth below the reference level 

‎ is the unit weight of water (defined as density in 
CPT_PROJECT_PARAMETERS.Water_Density_Field) 

7.2 Overwater Testing  

The critical fields related to pore pressure calculation for over water testing are: 

¶ CPT_GENERAL.Water_Depth 

¶ CPT_GENERAL.Zero_Location 

¶ CPT_GENERAL.Pre_drilled_Depth 

¶ CPT_GENERAL.Groundwater_Depth 
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If CPT_GENERAL.Water_Depth field has data then only CPT_GENERAL.Groundwater_Depth will be used, and the 
Groundwater fields on CPT_PROJECT_PARAMETERS are ignored.  This is only the case for over water 
testing. 

In the CPT_PROJECT_PARAMETERS table, the Water_Density_Field field is also required, and should be set 
appropriately for fresh or salt water. 

The following sections describe how to handle the various overwater scenarios.  The aim of corrections 
is to make the derived data in all strokes within the one PointID comparable. 

Derived parameters for tests using scenarios Zero at Seabed and Zero at Bottom of Borehole are 
comparable after the zero corrections have been applied, and the results are relative to the seabed. 

7.2.1 Zero on Deck / Surface 

In this case the transducers, including depth, are zeroed on deck (at atmospheric pressure).  Measured 
parameters donôt require zero corrections. 

Define 

¶ CPT_GENERAL.Water_Depth: Distance from seawater surface to seabed surface (required for 
Total Stress) 

¶ CPT_GENERAL.Zero_Location: S - Surface 

¶ CPT_GENERAL.Pre_drilled_Depth: Nothing or value as required, doesnôt influence calculation 

¶ CPT_GENERAL.Groundwater_Depth: Distance from deck level (0 depth) to the seawater surface 

 

In situ pore pressure is calculated relative to the atmospheric pressure using the following formula: 

 ὍὪ ᾀ ᾀ ὸὬὩὲ ό π 

ὍὪ  ᾀ ᾀ ὸὬὩὲ ό ᾀ  ᾀ  Ͻ‎ 

Where: 

ᾀ is the depth below the reference level 

ᾀ  is the groundwater depth below the reference level 

‎ is the unit weight of water (defined as density in 
CPT_PROJECT_PARAMETERS.Water_Density_Field) 

Total Stress and Effective Stress are calculated relative to deck/ground surface. 

7.2.2 Zero at Seabed 

In this scenario the transducers are zeroed at the seabed, with the hydrostatic pressure at that water 
depth.   

Define: 

¶ CPT_GENERAL.Water_Depth: Distance from seawater surface to seabed, doesnôt influence 
calculation 

¶ CPT_GENERAL.Zero_Location: SB - Seabed 

¶ CPT_GENERAL.Pre_drilled_Depth: Nothing or value as required, doesnôt influence calculation 
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¶ CPT_GENERAL.Groundwater_Depth: Nothing 

 

The in situ pore pressure, total stress and effective stress are calculated relative to the seabed, hence: 

ό ᾀ Ͻ‎ 

„ ᾀ Ͻ‎  

„ᴂ „  ό 

Where: 

ᾀ is the depth below the seabed 

‎ is the unit weight of water (defined as density in 
CPT_PROJECT_PARAMETERS.Water_Density_Field) 

‎  is the unit weight of saturated soil 

7.2.3 Zero at Bottom of Borehole 

This scenario applies when testing overwater and the transducers are zeroed the bottom of a predrilled 
borehole.  It is common for multiple 3 m strokes to be done down a borehole, possibly alternated with 
other in situ tests and sampling.  The corrections allow the multiple pushes to be comparable, by 
correcting the readings relative to the seabed surface. 

Define  

¶ CPT_GENERAL.Water_Depth: Distance from seawater surface to seabed, doesnôt influence 
calculation 

¶ CPT_GENERAL.Zero_Location: BB ï Bottom Borehole 

¶ CPT_GENERAL.Pre_drilled_Depth: Distance from seabed to bottom of borehole (where CPT 
started) 

¶ CPT_GENERAL.Groundwater_Depth: Nothing 

 

In this scenario the ή and ό will be corrected using the following formulas before they are used by the 
calculation code: 

ή ήᶻ ὨϽὥϽ‎ 

ό όᶻ ‎ϽὨ 

The in situ pore pressure, total stress and effective stress are calculated relative to the seabed, hence: 

ό Ὠ ᾀ Ͻ‎ 

„ ᾀ Ὠ Ͻ‎  

„ᴂ „  ό 

The CPT Tool calculation assumes data in the Depth field = d + z 

Lunne et al. (1997) and Fugro (1995) 
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Where: 

ή is the cone resistance corrected 

ήᶻ is the cone resistance measured 

ό is the pore pressure corrected 

όᶻ is the pore pressure measured 

ὥ is the cone area ratio 

‎ is the unit weight of water (defined as density in 
CPT_PROJECT_PARAMETERS.Water_Density_Field) 

Ὠ is the pre-drilled depth, depth from the seabed to bottom of the borehole where the CPT 
started 

ᾀ is the depth below the bottom of the borehole 

‎  is the unit weight of saturated soil 

1. The depth reference level for all strokes in a PointID must be the same.  Hence, when importing 
pushes with the reference depth at the bottom of the borehole the correspondence file must include the 
calculation Depth = d + z. 

2. Dissipation tests measured pore pressure and in situ pore pressure are corrected as described 
above.  And again Depth of the Dissipation test must = d + z. 
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8 Bulk Unit Weight  and Void Ratio  
Unit Weight and Void Ratio may be defined in two locations and are used in the order listed: 

1. CPT_POINT_MATERIAL_PROPERTIES table (Point Parameters ï Bottom half).  This allows the user 
to enter a depth profile.  If a depth range is missing a value, then the 
CPT_PROJECT_PARAMETERS table is used. 

2. CPT_PROJECT_PARAMETERS table.  A saturated and unsaturated unit weight must be defined, 
the former is applied bellow the water table and the later above the water table.  

If Unit Weight and Void Ratio are not defined in either table, then the Bulk Unit Weight and Void Ratio 
will not be defined, and most other parameters cannot be calculated. 
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9 Initiation of the CPT Data Calculation  

9.1 Primary Table Calculations  

The primary CPT calculation is initiated by changing data then saving on the following tables (or the 
split screen parent of these tables): 

¶ POINT 

¶ CPT_GENERAL 

¶ CPT_DATA 

¶ CPT_CONE_INFORMATION 

¶ CPT_POINT_PARAMETERS 

¶ CPT_POINT_CORRELATION_PARAMETERS 

¶ CPT_POINT_MATERIAL_PROPERTIES 

¶ CPT_PROJECT_PARAMETERS 

¶ CPT_PROJECT_CORRELATION_PARAMETERS 

¶  

¶ CPT_DESIGN_LINE_DATA 

The calculation will only take place if a Pastel Beige coloured field has been modified on the above 
tables.  This allows you to change metadata fields that do not have any effect on the calculation without 
having to recalculate the CPT test. 

The exception to this is the CPT_DATA table.  The calculation will occur if any cell has been modified, 
regardless of colour. 

The CPT calculation on POINT will only run when an existing POINT record has records on the CPT_DATA 
table, and the Elevation has changed and the new Elevation has a value. 

The automated CPT calculation when saving on these tables can be stopped by checking 
Suppress_Automatic_Calculation on CPT_PROJECT_PARAMETERS.  If it is checked, then the CPT will be 
flagged for pending calculation (see section 9.2). 

The calculation will not run when converting projects. 

Unless the Suppress_Calculation_on_Import on CPT_PROJECT_PARAMETERS is checked, the calculation will 
take place upon import. 

The table below lists the action taken on import under all combinations of the 
Suppress_Calculation_on_Import and Suppress_Automatic_Calculation values. 

Suppress Calculation on Import  Suppress Automatic Calculation  Action Taken  

FALSE FALSE CPT calculated 

TRUE FALSE CPT not calculated, not flagged 
pending calculation 

FALSE TRUE CPT Calculated 

TRUE TRUE CPT flagged pending calculation 
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When calling gINT Rules > Recalculate Current Table from a CPT Table, a form will display, giving 
you the following options: 

 

¶ Yes: will recalculate all CPTs in the project, this is equivalent to changing a value on the 
Project Parameter table.  This is the fastest way to revaluate the entire database of CPTs.  A 
progress bar will be shown to display the progress of the calculation.  This is normally the 
option to pick. 

¶ No: will use gINTôs native recalculate current table, which can be a very inefficient way to 
calculate the database of CPTs.  This option is not recommended. 

¶ Cancel: Cancels the call, and nothing is calculated. 

9.2 Batch Calculation  

The Batch Calculation feature allows the user to make changes to their CPT data, and flag the affected 
CPTs as pending for calculation instead of running the calculation immediately.  An example of where 
this feature may be useful is if you needed to enter the groundwater depth for each CPT on the 
CPT_GENERAL table.  It is much more convenient to calculate the CPTs after you have entered the 
groundwater depth for all tests at once rather than calculate each time you change of the groundwater 
depth. 

A CPT is flagged for calculation by inserting the current date time into the Calculation_Pending field on the 
CPT_GENERAL table.  When the CPT is calculated, the Calculation_Pending field is cleared for that CPT. 

The CPT Tool will flag CPTs for batch calculation in place of running the CPT calculation, if the 
Suppress_Automatic_Calculation checkbox on CPT_PROJECT_PARAMETERS is checked.  Like the CPT 
calculation, the Batch Calculation feature will flag all CPTs that were affected by the change.   For 
example, changing the values for a Cone ID record in the CPT_CONE_INFORMATION table will flag all 
CPTs that reference the modified Cone ID for batch calculation. 

The Batch Calculation Form allows you to view a list of flagged CPTs that are pending calculation, and 
calculate all, or a selection of CPTs. 

To launch the Batch Calculation Form, call the command INPUT | Add-Ins > Datgel CPT Tool > Batch 
Calculation, or press Ctrl + Shift + B. 

You should see a window similar to the following. 
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The form will display a list of the CPTs that have been flagged as pending calculation on the Pending 
Tests to Calculate grid.  When OK is clicked, the Batch Calculation Form will initiate the calculation for 
the CPTs that are listed on the Selected Tests to Calculate grid.   

You may use a combination of left click, left click-drag, ctrl + click and shift + click to select the desired 
CPTs, and the arrow buttons in the middle to move CPTs to the right or left grid.   

An explanation of the commands is as below: 

¶ Show All Tests ï Check this to show all CPTs in the Pending Tests to Calculate grid, 
regardless of if they have been flagged pending calculation.  Uncheck to hide the non-flagged 
CPTs. 

¶ Clear All Pending ï Clears the Calculation Pending flag on all CPTs without calculating them. 

¶ Select All Pending ï Selects all CPT calculations pending  

¶ OK ï Closes the form and initiates the CPT calculation for CPTs listed in the Selected Tests to 
Calculate grid.  Calculated CPTs will be cleared of the Calculation Pending flag.  A progress 
form will appear to display the progress of the calculations. 

¶ Cancel ï Closes the form without calculating any CPTs. 

9.3 Order of Calculation  

The order of calculation is: 

1. Derived parameters 

2. Soil Behaviour Type 

3. Formula Tool ï Library formulas 

4. Formula Tool ï Project formulas 

9.4 Dissipation Test  

The Dissipation test calculation is independent of the rest of the CPT table calculations.  You may need 
to manually make the Dissipation test recalculate after changing relevant CPT parameters / data for a 
PointID. 
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10 Derived Parameter s 
The following table presents the derived parameters.  These calculations are hard coded, and are 
calculated before the Formula Tool. 

Table 2 - Derived Parameters 

DGD Field Name  AGS RTA 
Field Name  

Caption  Symbol  Unit  Description  

Penetration_Rate     Rate calculated based on 
Time_Elapsed and Depth 

Bulk_Unit_Weight STCT_BUW Bulk Unit Weight  ‎ Ὧὔάϳ  Bulk unit weight, ‎  

In_Situ_Pore_Pressure STCT_PWPI In Situ u ό Ὧὖὥ In situ pore pressure, ό, refer to 

section 7 for a full explanation. 

Excess_Pore_Pressure STCT_PWPE Delta u Ўό Ὧὖὥ Excess pore pressure,  
Ўό  ό  ό 

Normalised_Excess_Pore_
Pressure 

 Normalised Delta 
u 

Normalis
ed Ўό 

 Normalised excess pore 

pressure, normalised Ўό 
   

 
 

Total_Stress STCT_TOTS Total Stress „  Ὧὖὥ In situ total vertical stress, 

„ В ‎Ўᾀ 

Effective_Stress STCT_EFFS Effective Stress „ᴂ  Ὧὖὥ In situ effective vertical stress, 
„ᴂ „ ό 

Total_Cone_Resistance STCT_QT qt  ή ὓὖὥ Total cone resistance,  

ή  ή  ό ρ  ὥϽρπ ;  

or if the instrument is zeroed at 
the bottom of the borehole 
(downhole)  

ή ήz ρ ὥ ό Ͻzρπ ‎
ϽὨϽρπ  

Total_Cone_Resistance_Mo
ving_Average 

 Moving Average 
qt 

 ὓὖὥ Moving average qt over distance 
defined on 
CPT_PROJECT_PARAMETERS 

Total_Cone_Resistance_Mo
ving_Average_Inc 

 Moving Average 
qt Included 

 ὓὖὥ Moving average qt that are not 
excluded over distance defined 
on CPT_PROJECT_PARAMETERS 

Net_Cone_Resistance STCT_QNET Qn ή ὓὖὥ Net cone resistance,  

ή  ή  „ Ͻρπ  

Corrected_Sleeve_Friction STCT_FT Ft Ὢ  Ὧὖὥ Sleeve friction corrected for pore 
pressure effects, 

 Ὢ  Ὢ 
   ɀ   

 

Friction_Ratio STCT_FRR Rf Ὑ Ϸ Friction ratio, 

Ὑ 
Ͻ
Ͻρππ, 

Ͻ
Ͻρππ, or 

Ͻ
Ͻρππ 

Normalised_Friction_Ratio STCT_FR Fr Ὂ Ϸ Normalised friction ratio, 

 Ὂ  
 Ͻ  

 

If  ή is not found, and if 

Calc_Qt_Fr_based_on_qc on 
CPT_PROJECT_PARAMETERS is set 
to true, then  ή  is used in place 

of ή. 
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DGD Field Name  AGS RTA 
Field Name  

Caption  Symbol  Unit  Description  

Normalised_Cone_Resistan
ce 

STCT_QNOR Qt ὗ - Normalised cone resistance, 

ὗ 
Ͻ  ɀ 

 
 

If  ή is not found, and if 

Calc_Qt_Fr_based_on_qc on 
CPT_PROJECT_PARAMETERS is set 
to true, then  ή  is used in place 

of ή. 

Stress_Normalised_Cone_R
esistance 

Stress_Normalise
d_Cone_Resistan
ce 

qt1 ή  - Stress normalised cone 
resistance (Kulhawy and Mayne 
1990, Jamiolkowski et al 

2001), ή   
 Ͻ

  Ͻ  

 

Pore_Pressure_Ratio STCT_BQ Bq ὄ - Pore pressure ratio, 

 ὄ  
ЎÕ

ήϽρπ ɀ „
 

Differential_Pore_Pressure_
Ratio 

STCT_DPPR DPPR ὈὖὖὙ - Differential pore pressure ratio, 

ὈὖὖὙ  
Ў

Ͻ
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11 Depth Co rrection Due to Inclination  
The Depth Correction Due to Inclination feature allows you to calculate and apply the depth correction 
to the Depth field in the CPT_DATA table, according to the formula detailed below. 

When this calculation is applied, Depth values in CPT_DATA are moved to Penetration_Length, and the 
corrected depth is written to Depth. 

The depth of cone penetration tests can be corrected for inclination by the equation: 

ᾀ  ὅϽὨὰ 

Where: 

ᾀ is the penetration depth, in m.  This value is written to Depth. 

ὰ is the penetration length, in m.  This value is taken from Depth, and is copied into 
Penetration_Length. 

ὅ is a correction factor for the effect of the inclination of the cone penetrometer relative to the 
vertical axis 

Equations for the calculation of the correction factor ὅ for the influence of the inclination of the cone 
penetrometer relative to the vertical axis, on the penetration depth: 

a) For a now-directional inclinometer, 

ὅ  ÃÏÓ‌ 

Where: 

‌ is the measured angle between the vertical axis and the axis of the cone 
penetrometer, in °.  This value is taken from Slope_Indicator in CPT_DATA. 

 

b) For a bi-axial inclinometer, 

ὅ ρ  ÔÁÎ‌  ÔÁÎ‍ Ȣ 

Where: 

‌ is the angle between the vertical axis and the axis and the projection of the cone 
penetrometer on the fixed vertical plane, in °.  This value is taken from Slope_Indicator_1 in 
CPT_DATA. 
 
‍ is the angle between the vertical axis and the axis and the projection of the cone 
penetrometer on a vertical plane that is perpendicular to the plane ‌, in °.  This value is 
taken from Slope_Indicator_2 in CPT_DATA. 

The Depth Correction function will use the bi-axial correction factor if Slope_Indicator_1 and Slope Indicator_2 
have data.  The now-directional correction factor will be used if Slope_Indicator has data.  Bi-axial has 
precedence over now-directional.   

If Slope_Indicator, Slope_Indicator_1 and Slope_Indicator_2 all have data, then bi-axial correction factor will be 
used. 
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11.1 Applying the Depth Correction due to Inclination Calculation  

The command apply the depth correction calculation is located in INPUT | Add-Ins > Datgel CPT Tool 
> Depth Correction due to Inclination.  This command will only run from the CPT_DATA table, meaning 
you must be on this table before you can run the command. 

The depth correction calculation will only be applied if the Penetration_Length field is empty for all rows for 
the selected CPT.  This is to ensure that the depth correction calculation is only applied once.  If you 
wish to recalculate or reapply the correction, you must either clear the values in the Penetration_Length 
field, or cut/paste the Penetration_Length values to the Depth field. 

The depth correction calculation can only be run if the Depth and Penetration_Length fields are in the same 
units (e.g. ft or m), and the units of Slope_Indicator, Slope_Indicator_1 and Slope_Indicator_2 are in degrees. 

Alternatively, the command INPUT | Add-Ins > Datgel CPT Tool > Depth Correction due to 
Inclination for multiple Strokes can be used to apply the depth correction calculation to all or selected 
list of CPTs.  This command can be run from any table in INPUT. 

You should see a window similar to the following: 

 

You may use a combination of left click, left click-drag, ctrl + click and shift + click to select the desired 
CPTs, and the arrow buttons in the middle to move CPTs to the right or left grid.   

Click OK to apply the depth correction calculation.  The progress bar and label on the bottom right will 
display the current status of the calculation process.  The depth correction calculation will only be 
applied if the Penetration_Length field is empty for all rows for a particular CPT, and the program will skip 
the CPT if a Penetration_Length value is found for a CPT.  A list of skipped CPTs will be displayed at the 
end of the calculation process. 
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12 Formula Tool  

12.1 Introduction  

The Formula Tool allows you to review and edit the preconfigured correlation formulas provided with 
the CPT Tool, and provides a way for you to define new correlation formulas.   

A tutorial on defining a formula is presented in Appendix B. 

To launch the Formula Tool Configuration form, call the command INPUT | Add-Ins > Datgel CPT Tool 
> Formula Tool Configuration. 

You should see a window similar to the following.  
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12.2 Formula Toolbar  

 

Hovering the mouse cursor over each item will show a tooltip with a short description of the item.  

Name Icon/Image Keyboard Shortcut Description 

New Formula  Ctrl + N Creates a new empty formula 

Save Formula  Ctrl + S Saves all changes to the gINT Library or 
Project database, depending on the selected 
Location 

Delete Formula  Ctrl + D Deletes the currently selected formula 

Undo Changes  Ctrl + U Reverts any changes made to the current 
formula to the state it was last saved 

Copy Current 
Formula 

 Ctrl + Shift + C Makes a copy of the currently selected 
formula, and adds it to the end of the Formula 
Grid. After copying, the copied formula will be 
selected, and you must enter a new unique 
name. 

Enable all 
Formulas 

  Checks the Enabled check box column for all 
formulas in the Formulas Grid 

Disable all 
Formulas 

  Unchecks the Enabled check box column for 
all formulas in the Formulas Grid 

Location 
 

 Location the Formula Configurations are 
stored. Select Library to load the Configuration 
stored in the current gINT Library, and Project 
to load the Configuration stored in the current 
gINT Project. 

At the time of CPT calculation, The Library 
formulas will be evaluated and calculated first, 
followed by the Project formulas.  Hence a 
formula in the Project can override a formula in 
the Library. 

Generate 
Validation 
Report for 
Current 
Formula 

  Generates a report containing full details of the 
currently selected formula, evaluated validation 
result and any errors or missing Table Field 
references in the current formula. 

Clicking the button will prompt you for a new 
text file path, and then automatically open the 
text file in a text editor program after the report 
has been generated. 

Generate 
Validation 
Report for All 
Formulas 

  Generates a report containing full details of the 
all formulas showing in the formula grid, 
evaluated validation result and any errors or 
missing Table Field references for each 
formula. 

Clicking the button will prompt you for a new 
text file path, and then automatically open the 
text file a text editor program after the report 
has been generated. 
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12.3 Data Tool Toolbar  

 

Hovering the mouse cursor over each item will show a tooltip with a short description of the item.  

Name Icon/Image Keyboard 
Shortcut 

Description 

Refresh Data 
Tool 

 Ctrl + R Clears, re-reads and reloads the Table 
and Field drop down list items from the 
current gINT Project. Use this to 
update the drop down list if you have 
added a new table or field after the 
Formula Configuration Form has been 
opened. 

Table Field 
Data Tool  

 Pastes the selected table and field as 
formatted text into the last focused 
configuration field. Refer to the Table 
Field Data Tool section of the manual 
for detailed information 

Function Data 
Tool  

 Pastes the selected function text into 
the last focused configuration field. 
Refer to 21 for detailed information 

12.3.1 Table Field Data Tool 

 

The Table Field Data Tool pastes the selected table and field as formatted text into the last focused 
configuration field.  The drop down list contains all tables and fields in the current gINT Project 
database.  When a Table is selected, the Field list will automatically filter to show only the fields for the 
selected table. 

The Table and Field drop down lists consist of three columns: 

 
 

¶ Table Name/Field Name ï database name of the Table or Field 

¶ Caption ï The caption text as configured in the Caption field in the gINT Table or Field 
Properties 

¶ Description ï The description text as configured in the Description field in the gINT Table or 
Field Properties 

The drop down list can be sorted by a column by clicking on the column header.  The columns can be 
resized by clicking and dragging the edges of the column header left or right.  The drop down list 
window can be resized by clicking and dragging the bottom right corner of the window. 
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The Paste  button will insert the selected table field into a formatted, table field reference text into 
the last focused configuration text field or grid cell.  The Paste button can insert text into the following 
Configuration fields: 

¶ Description 

¶ Any cell in the Variables Grid 

¶ Formula 

¶ Write Value To 

The table field reference format is as below: 

<<Table Name.Field Name>>  

Table field references in the Formula field are required to be surrounded by quotation marks.  The 
Table Field Data Tool will automatically add the quotation marks if pasting in the Formula field. The 
table field reference format for the Formula field is as below: 

" <<Table Name.Field Name>> "  

The pasted text will be inserted at the current position of the cursor in the fields.  Any highlighted text 
will be replaced by the inserted text.  Selecting an entire cell in the Variables grid will replace the 
contents of that cell with the inserted text. 

12.3.2 Function Data Tool 

 

The Table Field Data Tool pastes the selected function text into the last focused configuration field.  
The Function drop down list contains all functions, constants and operators that are available in the 
Formula Tool, it the correct syntax.  Each function is categorised as a type, and selecting a type in the 
Type drop down list will filter the function drop down list by that type. 

 

The Function drop down list consists of three columns: 

¶ Type ï type of function, can be filtered by a particular type by selecting a type in the Type drop 
down list 

¶ Function ï the function, constant or operator in the correct syntax as required by the Formula 
Tool.  The typical syntax composition of a function consists of the function name, followed by 
an open bracket, followed by a comma separated list of function parameters, followed by a 
closed bracket. 

FunctionNam e( Parameter 1, Parameter 2 [,... ])  

The function name is case sensitive.  All function parameters are required, unless noted 

otherwise.  If a function accepts an arbitrary number of parameters, it is denoted by ...  . 

¶ Description ï A short description about the function 
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The Paste  button will insert the selected function into last focused configuration text field or grid 
cell.  The Paste button can insert text into the following Configuration fields: 

¶ Description 

¶ Any cell in the Variables Grid 

¶ Formula 

¶ Write Value To 

Refer to section 23 Formula Tool and Data Correction Tool Functions for detailed information about the 
functions. 

12.4 Formulas Group  

 

The Formulas Group contains a list of formulas stored in the currently selected location.  Each row in 
the Grid represents one formula, and is listed in the order they are to be evaluated from first to last. 

Selecting a formula by either by clicking on a row, or pressing the up or down keys in the Grid will 
display the configuration associated with the selected formula in the Configuration Group.  The Name 
column values cannot be changed in this grid. It must be done in the Configuration Group after the 
formula has been selected.   

The Order of the formula can be changed in the Formulas Group with the up down buttons on the top 
left.  Descriptions of the bottom are listed below from top to bottom: 

¶ Move to Top ï Moves the currently selected formula to the top of the grid 

¶ Move Up ï Moves the currently selected formula up by one row 

¶ Move Down ï Moves the currently selected formula down by one row 

¶ Move to Bottom ï moves the currently selected formula to the bottom of the grid 

The formulas can be enabled or disabled by clicking on the corresponding check box in the Enabled 
column.  When the formula grid is active, pressing the Spacebar key will also toggle the enabled check 
box for the currently selected rows.  You can select multiple rows by left clicking and dragging down on 
the row header, or by holding the ctrl key while left clicking on the row headers. 
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12.5 Configuration Group  

  

The Configuration Group contains all the configurable options for the formula that is currently selected 
in the Formulas Grid. 

¶ Name ï Name of the formula.  The formula name must be unique for the configuration location.  
This means that you may have two formulas with the same name with one in current Library 
and one in the current Project.   

You will not be able to select another formula, or save the formula until a unique name is 
entered. 

¶ Order ï A numeric value of the order the formula will be evaluated.  If the result of the current 
formula is required to evaluate another formula, then the current formula should be placed at a 
higher order to than the other formula. 

The order cannot be changed in the Configuration Group.  Move the selected formula up or 
down using the up down buttons left of the Formulas Grid.  The numeric Order value will 
update itself when the order has changed.  

¶ Iteration - The round of iteration in which the current formula will be evaluated.  Default value 
is 1.  Functions which calculate the average of a correlation that is evaluated by the Formula 
Tool need to be run at a later iteration to the correlation. 

¶ Description ï Description of the formula.  It is not used or required in the formula calculation, 
and hence it is an optional field. 

¶ Table/Field References to Variables ï Declare the variables that are used in the formula 
expression in this grid.  The rows in this grid can be changed with the up down buttons on the 
left of this grid. Column definitions are listed below: 

¶ Variable Name ï Name of the variable.  The variable name can consist of alphanumeric 
characters [a-z, A-Z, 1-9], but must have at least one alphabetic character, and is case 
sensitive.  It cannot contain the following: 
o Symbols, such as `, $, # 
o White spaces or carriage return 
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In addition, a duplicate variable names for a particular formula is not permitted, and a 
variable name cannot be exactly the same as a function name. 

¶ Expression ï Table Field reference to where the variable value is to be retrieved from, or a 
text or numeric value.  The following is a list of rules and specifications regarding the 
Expression: 

o Table Field references must be in the format of <<Table.Field>>  

o If the referenced field is from the CPT_DATA table, then it will take the value from the 
field of the current row the CPT Tool is calculating. 

o If the referenced field is from any other table, it will retrieve the first result from a query 
to that table, filtered by the PointID and ItemKey values of the current CPT calculation, 
where appropriate. 

o To use the variable as a constant, enter a numeric value, or text that is not in the 

format of <<Table.Field>>  

¶ Unit ï Unit the value is required to be in to be used in the formula expression.  The 
Formula Tool will convert the variable from its source unit to the unit defined in this column 
before the value is used in the formula.   
The source unit can only be retrieved if the value in the Expression is a table/field 
reference, and is taken from the Unit field property of the named field. 
If no unit is specified, then the variable value is used as-is.  If a unit is specified, but a 
conversion factor cannot be determined, then the value is null. 

¶ Validation Value ï Value used to evaluate the formula when the Validate button is clicked, 
and in the Validation Reports.  The Validation Value has no effect on the actual CPT 
calculation, and is solely used in the Formula Configuration Form. 

¶ Formula ï The formula expression.  Refer to section 23 Formula Tool and Data Correction 
Tool Functions for a full list of available functions.  Variables declared in the Variables Grid 
above can be referenced in the formula expression.  String constants must be surrounded with 
quotation marks "" in order to differentiate it from a variable reference.  Spaces and carriage 
returns may be used liberally to improve readability. 

Table field references in the formula expression must be surrounded by quotation marks, i.e. 

"<<Table.Field>>" .  The Table Field Data Tool will automatically add the quotation marks 

when pasted in the formula expression field. 

¶ Write Value To ï The Table Field reference to where the result of the formula evaluation is to 

be written to.  The value in this field must be in the <<Table.Field>>  format, and must be 

from the CPT_DATA table. 

¶ Validate ï Click this button to evaluate the current formula expression, with the Validation 
Value set as the Variables.  If the evaluation was successful, the result will be written to the 
adjacent text field.  The Formatting Type and Value will be applied to the result, if defined.  Use 
Validate to spot check your formula expression for syntax errors, and to verify the formula 
returns an expected result. 

¶ Result Unit ï Unit of the result of the equation.  The evaluated result of the formula is 
converted from the Result Unit to the unit of the Write Value To field, if the two units are 
different.  If Result Unit is empty, the value is not converted and is written to the Write Value To 
Field as-is.  The lookup list of values in this field is sourced from the Field Units library table. 

¶ Enabled ï Check or uncheck to enable or disable the formula respectively from evaluating in 
the CPT calculation 

¶ Formatting Type and Value ï Formats the result to either decimal or significant figures, to the 
nearest specified value.  The formatting only applies to formula expressions that return a 
numeric value. 

¶ OK ï Saves the current state of the formulas in the Formula Configuration form to the selected 
location, and closes the form. 

¶ Cancel ï Discards any changes made in the Formula Configuration form and closes the form.  
The formulas will remain at the exact same state as before the Formula Configuration form was 
opened.  You will be prompted to save if changes are detected. 
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13 Data Correction Tool  

13.1 Introduction  

The Data Correction Tool allows you to apply one-off corrections to a selection of existing CPT data in 
your gINT Project.  The two fundamental correction types are the application of a formula (Correction), 
and shifting a record up or down by a relative number of units, such as metres (Offset).  

Each correction is defined as a ñFormulaò and can either be an Offset or a Correction.  The correction 
can be applied to any field from the CPT_DATA table, including Depth.  However, if you are correcting 
Depth, you must ensure that the correction will not result in duplicate depth values for a given CPT. 

The Formulas stored in the library are executed first, in the order they are listed in the grid, followed by 
the Formulas in the project, in the order they are listed in the grid.  If you wish to apply an offset and a 
correction to one particular field, then you must create two Formulas, one for the offset and the 
correction, and ensure they are listed in the desired order. 

To launch the Data Correction Tool, call the command INPUT | Add-Ins > Datgel CPT Tool > Data 
Correction Tool. 

You should see a window similar to the following. 
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13.2 Formula Toolbar  

 

Hovering the mouse cursor over each item will show a tooltip with a short description of the item.  

Name Icon/Image Keyboard Shortcut Description 

New Formula  Ctrl + N Creates a new empty formula in the current 
formula grid 

Save Formula  Ctrl + S Saves all changes to the gINT Library and 
Project database 

Delete Formula  Ctrl + D Deletes the currently selected formula 

Undo Changes  Ctrl + U Reverts any changes made to the current 
formula to the state it was last saved 

Copy Current 
Formula 

 Ctrl + Shift + C Makes a copy of the currently selected 
formula, and stores it in memory. 

Paste Formula  Ctrl + Shift + V Inserts the previously copied formula into the 
current formula grid 

Enable all 
Formulas 

 Ctrl + Shift + E Checks the Enabled check box column for all 
formulas in the current Formulas Grid 

Disable all 
Formulas 

 Ctrl + Shift + D Unchecks the Enabled check box column for 
all formulas in the current Formulas Grid 

13.3 Data Tool Toolbar  

 

Hovering the mouse cursor over each item will show a tooltip with a short description of the item.  

Name Icon/Image Keyboard 
Shortcut 

Description 

Refresh Data 
Tool 

 Ctrl + R Clears, re-reads and reloads the Table 
and Field drop down list items from the 
current gINT Project. Use this to 
update the drop down list if you have 
added a new table or field after the 
Data Correction Tool has been opened. 

Table Field 
Data Tool  

 Pastes the selected table and field as 
formatted text into the last focused 
configuration field. Refer to the Table 
Field Data Tool section of the manual 
for detailed information 

Function Data 
Tool  

 Pastes the selected function text into 
the last focused configuration field. 
Refer to 21 for detailed information 

13.3.1 Table Field Data Tool 

 

The Table Field Data Tool pastes the selected table and field as formatted text into the last focused 
configuration field.  The drop down list contains all tables and fields in the current gINT Project 
database.  When a Table is selected, the Field list will automatically filter to show only the fields for the 
selected table. 
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Currently, the Data Correction Tool only supports referencing fields on CPT_DATA, hence the Table has 
been fixed to CPT_DATA. 

The Table and Field drop down lists consist of three columns: 

 
 

¶ Table Name/Field Name ï database name of the Table or Field 

¶ Caption ï The caption text as configured in the Caption field in the gINT Table or Field 
Properties 

¶ Description ï The description text as configured in the Description field in the gINT Table or 
Field Properties 

The drop down list can be sorted by a column by clicking on the column header.  The columns can be 
resized by clicking and dragging the edges of the column header left or right.  The drop down list 
window can be resized by clicking and dragging the bottom right corner of the window. 

The Paste  button will insert the selected table field into a formatted, table field reference text into 
the last focused configuration text field or grid cell.  The Paste button can insert text into the following 
Configuration fields: 

¶ Description 

¶ Any cell in the Variables Grid 

¶ Formula 

¶ Name 

The table field reference format is as below: 

<<Table Name.Field Name>>  

Table field references in the Formula field are required to be surrounded by quotation marks.  The 
Table Field Data Tool will automatically add the quotation marks if pasting in the Formula field. The 
table field reference format for the Formula field is as below: 

" <<Table Name.Field Name>> "  

The pasted text will be inserted at the current position of the cursor in the fields.  Any highlighted text 
will be replaced by the inserted text.  Selecting an entire cell in the Variables grid will replace the 
contents of that cell with the inserted text. 

13.3.2 Function Data Tool 

 

The Table Field Data Tool pastes the selected function text into the last focused configuration field.  
The Function drop down list contains all functions, constants and operators that are available in the 
Formula Tool, it the correct syntax.  Each function is categorised as a type, and selecting a type in the 
Type drop down list will filter the function drop down list by that type. 
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The Function drop down list consists of three columns: 

¶ Type ï type of function, can be filtered by a particular type by selecting a type in the Type drop 
down list 

¶ Function ï the function, constant or operator in the correct syntax as required by the Formula 
Tool.  The typical syntax composition of a function consists of the function name, followed by 
an open bracket, followed by a comma separated list of function parameters, followed by a 
closed bracket. 

FunctionNam e(Parameter 1, Parameter 2 [,... ])  

The function name is case sensitive.  All function parameters are required, unless noted 

otherwise.  If a function accepts an arbitrary number of parameters, it is denoted by ...  . 

¶ Description ï A short description about the function 

The Paste  button will insert the selected table field into a formatted, table field reference text into 
the last focused configuration text field or grid cell.  The Paste button can insert text into the following 
Configuration fields: 

¶ Description 

¶ Any cell in the Variables Grid 

¶ Formula 

¶ Name 

Refer to section 23 Formula Tool and Data Correction Tool Functions for detailed information about the 
functions. 

13.4 Formulas Group  

 

The Formulas Group contains a list of formulas stored in the currently selected tab.  The formulas listed 
in the Library tab are stored in the gINT Library, and the Project tab in the current gINT Project 
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database. Each row in the Grid represents one formula, and is listed in the order they are to be 
evaluated from first to last. 

Selecting a formula by either by clicking on a row, or pressing the up or down keys in the Grid will 
display the configuration associated with the selected formula in the Configuration Group.  The Name 
column values cannot be changed in this grid. It must be done in the Configuration/Offset and 
Correction Group after the formula has been selected. 

The Enabled column maybe edited from the grid by clicking on the cell or pressing the space bar for the 
selected cell. 

The Order of the formula can be changed in the Formulas Group with the up down buttons on the top 
left.  Descriptions of the bottom are listed below from top to bottom: 

¶ Move to Top ï Moves the currently selected formula to the top of the grid 

¶ Move Up ï Moves the currently selected formula up by one row 

¶ Move Down ï Moves the currently selected formula down by one row 

¶ Move to Bottom ï moves the currently selected formula to the bottom of the grid 

13.5 Key Set Group  

 

Select the CPTs/Strokes you wish to run the data correction calculations to in this group. 

Source Table is fixed to CPT_GENERAL, which is the most appropriate table for selecting key sets for 
running calculations on the CPT_DATA table. 

¶ Source Table ï The table containing the key sets that define a unique list of CPTs.  The table 
is currently fixed to CPT_GENERAL. 

¶ Key Set Selector ï Defines the selection of CPTs to be calculated.  Click on the button on the 
right end of the text box to display the Key Set Selector Window. 

A window similar to the following should appear: 
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You may use a combination of left click, left click-drag, ctrl + click and shift + click to select the 
desired CPTs, and the arrow buttons in the middle to move CPTs to the right or left grid.   

13.6 Configuration Group  

 

The Configuration Group contains options identifying, defining and ordering for the currently selected 
formula in the Formulas grid. 

¶ Name ï Name of the formula.  The formula name must be unique for the formula grid.  This 
means that you may have two formulas with the same name in the current Library and Project, 
but not in the Library or Project only.   

You will not be able to select another formula, or save the formula until a unique name is 
entered. 

¶ Order ï a numeric value of the order the formula will be evaluated.  If the result of the current 
formula is required to evaluate another formula, then the current formula should be placed at a 
higher order to than the other formula. 

The order cannot be changed in the Configuration Group.  Move the selected formula up or 
down using the up down buttons left of the Formulas Grid.  The numeric Order value will 
update itself when the order has changed.  

¶ Iteration - The round of iteration in which the current formula will be evaluated.  Default value 
is 1.  Functions which calculate the average of a correlation that is evaluated by the Formula 
Tool need to be run at a later iteration to the correlation. 

¶ Description ï Description of the formula.  It is not used or required in the data correction 
calculation, and hence it is an optional field. 

¶ Source/Target Field ï The field on the Source Table where the value for the formula is read 
and written to.  This field can be any field on the Source Table, including key fields.  Use the 
drop-down combo box to select the field from the current Source Table. 

¶ Validate ï Click this button to evaluate the current formula expression, with the Validation 
Value set as the Variables.  The Validate button is only enabled if the current formula is a 
Correction type.  If the evaluation was successful, the result will be written to the adjacent text 
field.  The Formatting Type and Value will be applied to the result, if defined.  Use Validate to 
spot check your formula expression for syntax errors, and to verify the formula returns an 
expected result. 

¶ Enabled ï Check or uncheck to enable or disable the formula respectively from evaluating in 
the CPT calculation 
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¶ Formatting Type and Value ï Formats the result to either decimal or significant figures, to the 
nearest specified value.  The formatting only applies to formula expressions that return a 
numeric value. 

¶ OK ï Saves the current state of the formulas in the Data Correction Tool to the selected 
location, and closes the window. 

¶ Cancel ï Discards any changes made in the Data Correction Tool and closes the window.  
The formulas will remain at the exact same state as before the Formula Configuration form was 
opened.  You will be prompted to save if changes are detected. 

13.7 Offset and Correction Grou p 

The Offset and Correction group defines the formula type and options related to the for the currently 
selected formula. 

 

13.7.1 Offset 

This formula type allows for the vertical offset of columns/channels.  For example, the offset of sleave 
friction data. 

 

¶ Offset or Correction ï Choose the formula type, Offset or Correction.  If Offset is selected, the 
Offset subgroup is enabled, and the Correction subgroup is disabled, and vice versa. 

¶ Offset Reference Field ï Field that defines the offset reference field on the currently selected 
Source table.  The Offset calculation will read values in this field as a reference to offset the 
values in the source/target field.  A typical Offset Reference Field value would be Depth. 

¶ Direction ï Determines the offset direction.  Increase offsets the value to a greater depth, 
whereas Decrease offsets the value to a lesser depth. 

¶ Offset By ï The value to offset the source/target field by.  The unit of this value is taken from 
the Offset Reference Field.  For example, if the Offset Reference Field of Depth is in Metres, 
then the Offset By value will also be in Metres.  The Offset By value must be positive. 
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13.7.2 Correction 

This formula type allows for the alteration in value of data for a column based on a Formula.  For 
example: 

1. Re-zero the Depth column, to correct for an incorrect start depth applied during acquisition. 

2. Subtract 101.4 kPa from measured pore pressure. 

 

¶ Table/Field References to Variables ï Declare the variables that are used in the formula 
expression in this grid.  The rows in this grid can be changed with the up down buttons on the 
left of this grid. Column definitions are listed below: 

¶ Variable Name ï Name of the variable.  The variable name can consist of alphanumeric 
characters [a-z, A-Z, 1-9], but must have at least one alphabetic character, and is case 
sensitive.  It cannot contain the following: 
o Symbols, such as `, $, # 
o White spaces or carriage return 
In addition, duplicate variable names for a particular formula is not permitted, and a 
variable name cannot be exactly the same as a function name. 

¶ Expression ï Table Field reference to where the variable value is to be retrieved from, or a 
text or numeric value.  The following is a list of rules and specifications regarding the 
Expression: 

o Table Field references must be in the format of <<Table.Field>>  

o Referenced fields must be from the CPT_DATA table, and it will take the value from the 
field of the current row the CPT Tool is calculating. 

o To use the variable as a constant, enter a numeric value, or text that is not in the 

format of <<Table.Field>>  

¶ Validation Value ï Value used to evaluate the formula when the Validate button is clicked, 
and in the Validation Reports.  The Validation Value has no effect on the actual CPT 
calculation, and is solely used in the Formula Configuration Form. 

¶ Formula ï The formula expression.  Refer to section 23 Formula Tool and Data Correction 
Tool Functions for a full list of available functions.  Variables declared in the Variables Grid 
above can be referenced in the formula expression.  String constants must be surrounded with 
quotation marks "" in order to differentiate it from a variable reference.  Spaces and carriage 
returns may be used liberally to improve readability. 

Table field references in the formula expression must be surrounded by quotation marks, i.e. 

"<<Table.Field>>" .  The Table Field Data Tool will automatically add the quotation marks 

when pasted in the formula expression field. 
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14 Correlations  
The primary references for the correlation was Mayne (2007) and Lunne et al. (1997). 

Many of the correlations listed in this section use constants within a formula.  Users can set the 
constants in the following tables.  The tables are listed in order of priority. 

1. CPT_POINT_MATERIAL_PROPERTIES 

2. CPT_POINT_PARAMETERS or CPT_POINT_CORRELATION_PARAMETERS 

3. CPT_PROJECT_CORRELATION_PARAMETERS or CPT_PROJECT_PARAMETERS 

For example, if the Relative_Density_1_C0 field on CPT_POINT_ CORRELATION_PARAMETERS has a value it 
will be used in preference to the value, if any, on the CPT_PROJECT_CORRELATION_PARAMETERS table. 

The fields in the CPT_POINT_MATERIAL_PROPERTIES table allow the constants to be defined for depth 
ranges for a particular PointID.  A top and bottom depth must be specified when using the 
CPT_POINT_MATERIAL_PROPERTIES table, and the depth ranges must not overlap.  

14.1 Soil Behaviour Type 

The CPT Tool is supplied with five material type interpretation methods: 

¶ Eslami Fellenius 1997 

¶ Ramsey 2002 

¶ Robertson 1990 

¶ Robertson 1990 Extrapolated (axis extrapolated out) 

¶ Robertson et al. 1986 

¶ Robertson et al. 1986 ή vs. Ὑ (Applicable when u2 isnôt measured) 

¶ Schneider et al. 2008 (defined by formula in paperôs table 6) 

¶ Schmertmann 1978 

Additional methods may be defined by users in the DG_CPT* library tables.  See section 15 Creating a 
New Soil Behaviour Type. 

The CPT_DATA table allows for two methods to be defined.  The methods are set on the 
CPT_PROJECT_PARAMETERS and the CPT_POINT_PARAMETERS tables.   

If the interpretation is done using 2 graphs, then the first single (not a list of numbers) result is used as 
the overall material classification.   

Examples: 

¶ If Soil Zone 1 Graph 1 = 5 and Soil Zone 1 Graph 2 = 6, then Soil Class Number 1 will = 5 

¶ If Soil Zone 1 Graph 1 = 9,10,11,12 and Soil Zone 1 Graph 2 = 9, then Soil Class Number 1 will 
= 9 

If a point lies on the border of two zones, then the soil zone will be an appended string of both numbers, 
e.g. ñ9,10ò.  The material type graph reports will print a black dot for these dual points. 

If the graph parameters are not within the range of the graph, then the Description field is set to ñNo 
Matchò. 
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If the X and/or Y axes of the graph are in a particular measurement unit (e.g. MPa), then the unit must 
be defined in the Graph_#_Parameter_Field_X_Unit and Graph_#_Parameter_Field_Y_Unit fields in the 
DG_CPT_SOIL_CLASS_METHOD table respectively.  The value from the field reference defined in 
Graph_#_Parameter_Field_X or Graph_#_Parameter_Field_Y is converted from the unit it is currently in to the 
unit defined in the unit specified in the Graph_#_Parameter_Field_X_Unit and Graph_#_Parameter_Field_Y_Unit 
fields before determining which zone the value lies in.  

14.2 Undrained Shear Strength and Consistency Term  

14.2.1 Undrained Shear Strength 1 

Undrained Shear Strength 1 ( ί) in Undrained_Shear_Strength_Term_1 is defined as: 

When qt has data, 

ί
ήϽρπ  „

ὔ
 

Otherwise, 

ί 
ήϽρπ  „

ὔ
 

NCHRP Synthesis 368 p 39 

ὔ  and ὔ  are defined on the CPT_POINT_MATERIAL_PROPERTIES, 
CPT_POINT_CORRELATION_PARAMETERS and CPT_PROJECT_CORRELATION_PARAMETERS tables. Different 
values for ὔ  and ὔ  can be defined for when ή or ή is either greater than or equal to, or less than a 
defined break point. Each of these tables have six fields from which the ὔ  and ὔ  values, and the ή 
and ή break point values are stored and retrieved for the calculation of ί. 

Field Name  Description  

Undrained_Shear_Strength_1_Nk_qc_BP Break point used to determine which ὔ  to use in the 

 ί calculation 

Undrained_Shear_Strength_1_Nk_qc_LT_BP Used as the ὔ  in the  ί calculation, where ή does not 

have data, and ή is less than the break point. 

Undrained_Shear_Strength_1_Nk_qc_GTE_BP Used as the ὔ  in the  ί calculation, where ή does not 

have data, and ή is greater than or equal to the break 

point. 

Undrained_Shear_Strength_1_Nkt_qt_BP Break point used to determine which ὔ  to use in the 

 ί calculation 

Undrained_Shear_Strength_1_Nkt_qt_LT_BP Used as the ὔ  in the  ί calculation, where ή has data, 

and ή is less than the break point. 

Undrained_Shear_Strength_1_Nkt_qt_GTE_BP Used as the ὔ  in the  ί calculation, where ή has data, 

and ή is greater than or equal to the break point. 

The fields in the CPT_POINT_MATERIAL_PROPERTIES table allow the ὔ  and ὔ  to be defined for depth 
ranges for a particular PointID.  A top and bottom depth must be specified when using the 
CPT_POINT_MATERIAL_PROPERTIES table, and the depth ranges must not overlap.  

If the CPT_POINT_MATERIAL_PROPERTIES table is populated for the calculated PointID, the ὔ  or ὔ  that 
lies within the depth range of the current depth of the row in the CPT_DATA table is used to calculate ί. 
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If a matching depth range for the current depth is not found, or ὔ  or ὔ  is missing, then the value is 
taken from the CPT_POINT_CORRELATION_PARAMETERS or the CPT_PROJECT_CORRELATION_PARAMETERS 
tables. 

14.2.2 Undrained Shear Strength 1 Term 

The Undrained_Shear_Strength_Term_1 is defined based on the value of the Undrained_Shear_Strength_1 field 
and the values in the DG_LOG_CONSISTENCY_DENSITY library table. 

14.2.3 Undrained Shear Strength 2 

Undrained Shear Strength 2 ( ί) in Undrained_Shear_Strength_Term_2 is defined as: 

When qt has data, 

Ó
ÑϽρπ

.
 

Otherwise, 

ί 
ÑϽρπ

.
 

Where: 

ὔ  is stored in the Undrained_Shear_Strength_2_Nkt field. 

ὔ is stored in the Undrained_Shear_Strength_2_Nk field. 

The variables are stored on CPT_POINT_MATERIAL_PROPERTIES, CPT_POINT_CORRELATION_PARAMETERS 
and CPT_PROJECT_CORRELATION_PARAMETERS tables. 

The fields in the CPT_POINT_MATERIAL_PROPERTIES table allow the ὔ  and ὔ  to be defined for depth 
ranges for a particular PointID.  A top and bottom depth must be specified when using the 
CPT_POINT_MATERIAL_PROPERTIES table, and the depth ranges must not overlap.  

If the CPT_POINT_MATERIAL_PROPERTIES table is populated for the calculated PointID, the ὔ  or ὔ  that 
lies within the depth range of the current depth of the row in the CPT_DATA table is used to calculate ί. 

If a matching depth range for the current depth is not found, or ὔ  or ὔ  is missing, then the value is 
taken from the CPT_POINT_CORRELATION_PARAMETERS or the CPT_PROJECT_CORRELATION_PARAMETERS 
tables. 

14.2.4 Undrained Shear Strength 2 Term 

The Undrained_Shear_Strength_Term_2 is defined based on the value of the Undrained_Shear_Strength_2 field 
and the values in the DG_LOG_CONSISTENCY_DENSITY library table. 

14.2.5 Undrained Shear Strength 3 

Undrained Shear Strength 3 ( ί) based on CSSM in Undrained_Shear_Strength_3 is defined as: 

When qt has data, 

Ó πȢυϽ ÓÉÎהϽ/#2Ͻ ʎ ᴂ   
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Wroth (1984), NCHRP Synthesis 368 p 39 

Where: 

‰ᴂ is taken from the first of these fields with data: Effective_Friction_Angle_3 and 
Effective_Friction_Angle_1 

ὕὅὙ is taken from Overconsolidation_Ratio_1 

ɤ ρ # #ϳ , typically low to medium sensitivity clays are πȢχ ɤ πȢψ , and sensitive and 
structured clays are πȢω ɤ ρȢπ, and is stored in the Undrained_Shear_Strength_3_Lambda field. 

ɤ is stored on CPT_POINT_CORRELATION_PARAMETERS and CPT_PROJECT_CORRELATION_PARAMETERS 
tables. 

14.2.6 Undrained Shear Strength 3 Term 

The Undrained_Shear_Strength_Term_3 is defined based on the value of the Undrained_Shear_Strength_3 field 
and the values similar to that in DG_LOG_CONSISTENCY_DENSITY library table. 

14.2.7 Undrained Shear Strength 4 

Undrained Shear Strength 4 ( ί) in Undrained_Shear_Strength_4 is defined as: 

Ó #Ͻ ʎᴂ   

Trak et al. (1980), Terzaghi et al. (1996), NCHRP Synthesis 368 p 40 

Where: 

ʎᴂ  is taken from Preconsolidation_Stress_1 

ὅ is 0.22 in the published formula, and is stored in the Undrained_Shear_Strength_4_C1 field. 

ὅ is stored on CPT_POINT_CORRELATION_PARAMETERS and CPT_PROJECT_CORRELATION_PARAMETERS 
tables. 

14.2.8 Undrained Shear Strength 4 Term 

The Undrained_Shear_Strength_Term_4 is defined based on the value of the Undrained_Shear_Strength_4 field 
and the values similar to that in DG_LOG_CONSISTENCY_DENSITY library table. 

14.2.9 Undrained Shear Strength 5 

Undrained Shear Strength 5 ( ί) in Undrained_Shear_Strength_5 is defined as: 

Ó
ЎÕ

.Ў
   

Robertson (2009), pp 28-29 

Where: 

ЎÕ  is taken from Excess_Pore_Pressure field 

.Ў  is taken from Undrained_Shear_Strength_5_N field 
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.Ў  is stored on CPT_POINT_CORRELATION_PARAMETERS and CPT_PROJECT_CORRELATION_PARAMETERS 
tables. 

14.2.10 Undrained Shear Strength 5 Term 

The Undrained_Shear_Strength_Term_5 is defined based on the value of the Undrained_Shear_Strength_5 field 
and the values similar to that in DG_LOG_CONSISTENCY_DENSITY library table. 

14.3 Relative Density and Relative Density Term  

14.3.1 Relative Density 1 

Relative density (Ὀ) in Relative_Density_1 is defined as: 

Ὀ   
ρ

ὅ
ÌÎ
ήϽρπϽὡὩὬὶ

 ὅ „ᴂ   
 Ͻρππ 

Baldi et al. (1986) and Al-Homoud and Wehr (2006), CPT in Geotechnical Practice p 83 

Where: 

ὅ is stored in the Relative_Density_1_C0 field.  Published value for normally consolidated 157, 
over consolidated 181 

ὅ is stored in the Relative_Density_1_C1 field.  Published value is 0.55 

ὅ is stored in the Relative_Density_1_C2 field.  Published value for normally consolidated 2.41, 
over consolidated 2.46 

ὡὩὬὶ is the Wehr Correction for Calcareous Soils, this constant is defined in the 
Relative_Density_1_Wehr_Correction field and was suggested in Al-Homoud and Wehr (2006).  If the 
field is empty the default is 1. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.3.2 Relative Density Term 1 

Relative density term in Relative_Density_Term_1 is defined based on Relative_Density_1 on the CPT_DATA 
table and the values in the DG_LOG_CONSISTENCY_DENSITY library table. 

14.3.3 Relative Density 2 

Relative density (Ὀ) in Relative_Density_2 is defined as: 

Ὀ ρππϽ#ϽÌÎ
Ñ ʎϳ

ʎ ᴂʎϳ
#  

Jamiolkowski et al. (2001), NCHRP Synthesis 368 pp 41-42 

Where: 

ὅ is stored in the Relative_Density_2_C1 field.  Published value is 0.268 for all sands 

ὅ is stored in the Relative_Density_2_C2 field.  For average compressibility: C2 = -0.675, for high 
compressibility and sands of carbonate or calcareous composition: C2 <= 1.0, for low 
compressibility: C2 >= -2.0 
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The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.3.4 Relative Density Term 2 

Relative density term in Relative_Density_Term_2 is defined based on Relative_Density_2 on the CPT_DATA 
table and the values in the DG_LOG_CONSISTENCY_DENSITY library table. 

14.3.5 Relative Density 3 

Relative density (Ὀ) in Relative_Density_3 is defined as: 

Ὀ   
Ñ

σπυϽ#Ͻ/#2Ȣ ϽρȢς πȢπυϽÌÏÇÔρππϳ

Ȣ

Ͻρππ 

Kulhawy and Mayne (1990), CPT in Geotechnical Practice p 84 

Where: 

ὅ is stored in the Relative_Density_3_C1 field.  Published values range from 0.91 for low 
compressibility, 1.0 for medium compressible sands, to 1.09 for highly compressible 

ὸ is time in years and stored in the Relative_Density_3_t field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.3.6 Relative Density Term 3 

Relative density term in Relative_Density_Term_3 is defined based on Relative_Density_3 on the CPT_DATA 
table and the values in the DG_LOG_CONSISTENCY_DENSITY library table. 

14.4 Soil Behaviour Type Index  

14.4.1 Soil Behaviour Type Index 1 

The soil behaviour type index (Ὅ) in Soil_Behaviour_Type_Index_1 is defined as: 

Ὅ ὅ  ÌÏÇὗ  ÌÏÇὊ  ὅ Ȣ 

Robertson and Wride (1998) 

Where: 

ὅ is 3.47 in the published formula, and is stored in the Soil_Behaviour_Type_Index_1_C1 field. 

ὅ is 1.22 in the published formula, and is stored in the Soil_Behaviour_Type_Index_1_C2 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.4.2 Soil Behaviour Type Index 2 

The soil behaviour type index (Ὅ) in Soil_Behaviour_Type_Index_2 is defined as: 

Ὅ ὅ  ÌÏÇὗ ρ ὄ  ὅ  ὅϽÌÏÇὊ  
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Jefferies and Davies (1993), NCHRP Synthesis 368 p 27 

Where: 

ὅ is 3 in the published formula, and is stored in the Soil_Behaviour_Type_Index_2_C1 field. 

ὅ is 1.5 in the published formula, and is stored in the Soil_Behaviour_Type_Index_2_C2 field. 

ὅ is 1.3 in the published formula, and is stored in the Soil_Behaviour_Type_Index_2_C3 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.4.3 Soil Behaviour Type Index 3 

The non-normalized Soil Behaviour Type Index (Ὅ ) in Soil_Behaviour_Type_Index_3 is defined as: 

Ὅ ὅ  ÌÏÇ
ήὸ έὶ ήὧ

ὴὥ
  ÌÏÇὙ ὅ

Ȣ

 

Robertson (2010), CPT 10, paper 2-56 (http://www.cpt10.com/PDF_Files/2-56RobSBT.pdf) 

Where: 

ὅ is 3.47 in the published formula and is stored in the Soil_Behaviour_Type_Index_3_C1 field. 

ήὸ is taken from the Total_Cone_Resistance field on the CPT_DATA table. 

ήὧ is taken from the Cone_Resistance field on the CPT_DATA table. 

ὴ is the Atmospheric pressure, 101.4 kPa, and is set in the Formula Tool. 

Ὑ is taken from the Friction_Ratio field on the CPT_DATA table. 

ὅ is 1.22 in the published formula and is stored in the Soil_Behaviour_Type_Index_3_C2 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.5 SPT N60 Value 

14.5.1 SPT N60 Value 1 

The SPT ὔ  in SPT_N60_1 is defined as: 

ὔ  
ήϽρπ

ὅϽ ὴ ρ  
Ὅ
ὅ

 

Robertson and Wride (1998), CPT in Geotechnical Practice p 151 

Where: 

ὅ is 8.5 in the published formula, and is stored in the SPT_N60_1_C1 field. 

ὅ is 4.6 in the published formula, and is stored in the SPT_N60_1_C2 field. 
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ὴ is the Atmospheric pressure, 100 kPa, and cannot be changed in the CPT Tool. 

Ὅ is stored in the Soil_Behaviour_Type_Index_1 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.5.2 SPT N60 Value 2 

The SPT ὔ  in SPT_N60_2 is defined as: 

ὔ  
ή

ὅϽρ  
Ὅ
ὅ

 

Jefferies and Davies (1993) 

Where: 

ὅ is 0.85 in the published formula, and is stored in the SPT_N60_2_C1 field. 

ὅ is 4.75 in the published formula, and is stored in the SPT_N60_2_C2 field. 

Ὅ is stored in the Soil_Behaviour_Type_Index_2 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.6 SPT Average N60 Value  

The SPT average N60 value is a stepped average of SPT N60 values in the SPT_N60_1 or SPT_N60_2 
fields in the CPT_DATA table for each defined depth interval step.  

The average of the N60 values is calculated for each depth interval step, and the result is recorded in 
the SPT_ Average_N60_1 or SPT_Average_N60_2 fields in the CPT_DATA table for each row in that interval 
step. 

The depth interval distance is defined on the SPT_N60_Average_Interval field on 
CPT_POINT_CORRELATION_PARAMETERS and CPT_PROJECT_CORRELATION_PARAMETERS tables, and is in 
metres.  

14.7 Shear Wave Velocity  

14.7.1 Shear Wave Velocity 1 (All Soils) 

Shear Wave velocity 1 (ὠ) in Shear_Wave_Velocity_1 is defined as: 

 
ὠ  ὅϽ ÌÏÇὪ  ὅ 

Mayne (2006), NCHRP Synthesis 368 p 30 

Where: 

ὅ is 118.8 in the published formula, and is stored in the Shear_Wave_Velocity_1_C1 field. 

ὅ is 18.5 in the published formula, and is stored in the Shear_Wave_Velocity_1_C2 field. 
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The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.7.2 Shear Wave Velocity 2 (All Soils) 

Shear Wave velocity 2 (ὠ) in Shear_Wave_Velocity_2 is defined as: 

 

ὠ  ὅϽ ÌÏÇήϽρπ  ὅ Ͻ
Ὢ

ήϽρπ
 Ͻρππ  

Hegazy and Mayne (1995), NCHRP Synthesis 368 p 30 

Where: 

ὅ is 10.1 in the published formula, and is stored in the Shear_Wave_Velocity_2_C1 field. 

ὅ is 11.4 in the published formula, and is stored in the Shear_Wave_Velocity_2_C2 field. 

ὅ is 1.67 in the published formula, and is stored in the Shear_Wave_Velocity_2_C3 field. 

ὅ is 0.3 in the published formula, and is stored in the Shear_Wave_Velocity_2_C4 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation of ὠ is calculated when the Soil_Type_1 field value on the CPT_DATA table has any value 
for that row. 

14.7.3 Shear Wave Velocity 3 (Clays) 

Shear Wave velocity 3 (ὠ) in Shear_Wave_Velocity_3 is defined as: 

ὠ  ὅϽήϽρπ  

 
Mayne and Rix (1995), NCHRP Synthesis 368 p 30 

Where: 

ὅ is 1.75 in the published formula, and is stored in the Shear_Wave_Velocity_3_C1 field. 

ὅ is 0.627 in the published formula, and is stored in the Shear_Wave_Velocity_3_C2 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation of ὠ is calculated only when the Soil_Type_1 field value on the CPT_DATA table is Fine or 
Mixed for that row. 

14.7.4 Shear Wave Velocity 4 (Sands) 

Shear Wave velocity 4 (ὠ) in Shear_Wave_Velocity_4 is defined as: 

 

ὠ  ὅϽή Ͻ„ᴂ Ͻρπ   

Baldi et al. (1989), NCHRP Synthesis 368 p 30 
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Where: 

ὅ is 277 in the published formula, and is stored in the Shear_Wave_Velocity_4_C1 field. 

ὅ is 0.13 in the published formula, and is stored in the Shear_Wave_Velocity_4_C2 field. 

ὅ is 0.27 in the published formula, and is stored in the Shear_Wave_Velocity_4_C3 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation of ὠ is calculated only when the Soil_Type_1 field value on the CPT_DATA table is Coarse 
or Mixed for that row. 

14.8 Unit Weight  

14.8.1 Dry Unit Weight 1 (Sands) 

Dry Unit Weight 1 (‎ ) in Dry_Unit_Weight_1 is defined as: 

 

‎  ὅϽÌÏÇή ὅ   

Mayne (2007), NCHRP Synthesis 368 p 31 

Where: 

ὅ is 1.89 in the published formula, and is stored in the Dry_Unit_Weight_1_C1 field. 

ὅ is 11.8 in the published formula, and is stored in the Dry_Unit_Weight_1_C2 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation of ὠ is calculated only when the Soil_Type_1 field value on the CPT_DATA table is Coarse 
or Mixed for that row. 

14.8.2 Saturated Unit Weight 1 

Saturated Unit Weight 1 (‎ ) in Saturated_Unit_Weight_1 is defined as: 

 
‎  ὅϽÌÏÇὠ ὅϽÌÏÇᾀ   

Mayne (2007), NCHRP Synthesis 368 p 31 

Where: 

ὅ is 8.32 in the published formula, and is stored in the Saturated_Unit_Weight_1_C1 field 

ὅ is 1.61 in the published formula, and is stored in the Saturated_Unit_Weight_1_C2 field 

ᾀ is Depth 

ὠ is taken from the first of these fields with data: Shear_Wave_Velocity_Extrapolated or 
Shear_Wave_Velocity_1  
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The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation is applicable to all soil types. 

14.8.3 Saturated Unit Weight 2 

Saturated Unit Weight 2 (‎ ) in Saturated_Unit_Weight_2 is defined as: 

 
‎  ὅϽÌÏÇὪ ὅϽὋ ὅ 

Mayne (2007), NCHRP Synthesis 368 p 32 

Where: 

ὅ is 2.6 in the published formula, and is stored in the Saturated_Unit_Weight_2_C1 field 

ὅ is 15 in the published formula, and is stored in the Saturated_Unit_Weight_2_C2 field 

ὅ is 26.5 in the published formula, and is stored in the Saturated_Unit_Weight_2_C3 field 

Ὃ is Specific Gravity of Solids, typically 2.4 to 2.9, and is stored in the Specific_Gravity_of_Solids 
field on CPT_PROJECT_CORRELATION_PARAMETERS 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation is applicable to all soil types. 

14.9 Small -Strain Shear Modulus  

14.9.1 Small-Strain Shear Modulus 1 (Sands) 

Small-Strain Shear Modulus 1 (Ὃ) of sand in Small_Strain_Shear_Modulus_1 is defined as: 

 

Ὃ  ὅϽ 
ή Ͻ ρπ

„ᴂ
Ͻ ή 

Rix and Stokoe (1992), CPT in Geotechnical Practice p 94 

Where: 

ὅ is 1634 in the published formula, and is stored in the Small_Strain_Shear_Modulus_1_C1 field 

ὅ is -0.75 in the published formula, and is stored in the Small_Strain_Shear_Modulus_1_C2 field 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation of Ὃ is calculated only when the Soil_Type_1 field value on the CPT_DATA table is Coarse 
or Mixed for that row. 

14.9.2 Small-Strain Shear Modulus 2  

Small-Strain Shear Modulus 2 (Ὃ) in Small_Strain_Shear_Modulus_2 is defined as: 
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Ὃ  
‎

Ὣ
 Ͻ ὠ  

Elastic theory, CPT in Geotechnical Practice p 74 and 94, NCHRP Synthesis 368 p 31 

Where: 

ὠ is taken from the first of these fields with data: Shear_Wave_Velocity_Extrapolated or 
Shear_Wave_Velocity_1 

‎  is taken from Bulk_Unit_Weight 

This correlation of Ὃ is applicable to all soil types. 

14.10 Youngôs Modulus 

Youngôs Modulus 1 (Ὁ) in Youngs_Modulus_1 is defined as: 

Ὁ  ςϽρ  ’ϽὋ 

Elastic theory, CPT in Geotechnical Practice p 74 and 94, NCHRP Synthesis 368 p 32 

Where: 

‡ = 0.2 is applied and can be varied in the Formula Tool.  Published literature states: ‡ᴂ = 0.2 
applies for drained soils and ‡ = 0.5 applies for undrained soils 

Ὃ is taken from Small_Strain_Shear_Modulus_2 

This correlation of Ὁ is applicable to all soil types. 

14.11 Constrained Modulus  

14.11.1 Constrained Modulus 1 

The constrained modulus 1 (ὓ) in Constrained_Modulus_1 is defined as: 

ὓ ὅϽή  „ Ͻρπ  

Kulhawy and Mayne (1990), NCHRP Synthesis 368 p 33 

Where: 

ὅ is 8.25 in the published formula, and is stored in the Constrained_Modulus_1_C1 field. 

The constant is stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.11.2 Constrained Modulus 2 

The constrained modulus 2 (ὓ) in Constrained_Modulus_2 is defined as: 

ὓ ὅϽὋ 

Burns and Mayne (2002), NCHRP Synthesis 368 pp 33-34 

Where: 
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ὅ is 0.02 for organic plastic clays up to 2 for over consolidated quartz sands in the published 
literature, and is stored in the Constrained_Modulus_2_C1 field 

Ὃ is taken from Small_Strain_Shear_Modulus_2 

The constant is stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation of ὓ is applicable to all soil types. 

This global approach to defining ὅ is potentially inaccurate, it would be better to define the constant 
based on soil type with depth. 

14.12 Coefficient of Volume Change  

The coefficient of volume change 1 (ά ) in Coefficent_Volume_Change_1 is defined as: 

ά
ρ

ὓ
 

CPT in Geotechnical Practice p 71  

Where: 

ὓ the constrained modulus, and is taken from the Constrained_Modulus_1 field. 

14.13 Compression Index  

The Compression Index 1 (ὅ) in Compression_Index_1 is defined as: 

ὅ
ςȢσρ ὩϽ„Ͻρπ

ὓ
 

CPT in Geotechnical Practice p 71 

Where: 

Ὡ is the Void Ratio, and is stored in the Void_Ratio field. 

ὓ is the constrained modulus, and is taken from the Constrained_Modulus_1 field. 

The constant and Ὡ are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.14 Preconsolidation Stress  and Overconsolidation Ratio  

14.14.1 Preconsolidation Stress 1 and Overconsolidation Ratio 1 

The Preconsolidation Stress 1 („ᴂ) of clay in Preconsolidation_Stress_1 is defined as: 

„ᴂ ὅϽήϽρπ  „  

Mayne (1995), Demers and Leroueil (2002), NCHRP Synthesis 368 p 34 

Where: 
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ὅ is 0.33 in the published formula, and is stored in the Preconsolidation_Stress_1_C1 field. 

The constant is stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

The overconsolidation ratio 1 in Overconsolidation_Ratio_1 is defined as: 

ὕὅὙ
„ᴂ

„ ᴂ
 

„ᴂ is taken from Preconsolidation_Stress_1 field 

14.14.2 Preconsolidation Stress 2 and Overconsolidation Ratio 2 

The Preconsolidation Stress 2 („ᴂ) of clay in Preconsolidation_Stress_2 is defined as: 

„ ὅϽЎό 

Chen and Mayne (1996), NCHRP Synthesis 368 p 34 

Where: 

ὅ is 0.53 in the published formula, and is stored in the Preconsolidation_Stress_2_C1 field. 

The constant is stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

The overconsolidation ratio 2 in Overconsolidation_Ratio_2 is defined as: 

ὕὅὙ
„ᴂ

„ ᴂ
 

„ᴂ is taken from Preconsolidation_Stress_2 field 

14.14.3 Preconsolidation Stress 3 and Overconsolidation Ratio 3 

The Preconsolidation Stress 3 („ᴂ) of clay in Preconsolidation_Stress_3 is defined as: 

„ᴂ ὅϽήϽρπ  ό  

Mayne (2005), NCHRP Synthesis 368 p 35 

Where: 

ὅ is 0.6 in the published formula, and is stored in the Preconsolidation_Stress_3_C1 field. 

The constant is stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

The overconsolidation ratio 3 in Overconsolidation_Ratio_3 is defined as: 

ὕὅὙ
„ᴂ

„ ᴂ
 

„ᴂ is taken from Preconsolidation_Stress_3 field 
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14.14.4 Preconsolidation Stress 4 and Overconsolidation Ratio 4 

The Preconsolidation Stress 4 („ᴂ) of clay in Preconsolidation_Stress_4 is defined as: 

„ ὅϽὗ Ͻ„ ᴂ 

Robertson (2009), Guide to CPT p 31 

Where: 

ὅ is 0.25 in the published formula, and is stored in the Preconsolidation_Stress_4_C1 field 

ὅ is 1.25 in the published formula, and is stored in the Preconsolidation_Stress_4_C2 field 

The constant is stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

The overconsolidation ratio 4 in Overconsolidation_Ratio_4 is defined as: 

ὕὅὙ
„ᴂ

„ ᴂ
 

„ᴂ is taken from Preconsolidation_Stress_4 field 

14.14.5 Preconsolidation Stress 5 and Overconsolidation Ratio 5 

The Preconsolidation Stress 5 („ᴂ) of sand in Preconsolidation_Stress_5 is defined as: 

„  
ὅϽήϽρπ„ϳ

ρ ÓÉÎ‰ Ͻ„ ᴂ„ϳ

  

Ͻ„ ᴂ 

Mayne (2005), NCHRP Synthesis 368 p 35 

Where: 

ὅ is 0.192 in the published formula, and is stored in the Preconsolidation_Stress_5_C1 field 

ὅ is 0.22 in the published formula, and is stored in the Preconsolidation_Stress_5_C2 field 

ὅ is 0.31 in the published formula, and is stored in the Preconsolidation_Stress_5_C3 field 

ὅ is 0.27 in the published formula, and is stored in the Preconsolidation_Stress_5_C4 field 

‰ is taken from Effective_Friction_Angle_3 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

The overconsolidation ratio 5 in Overconsolidation_Ratio_5 is defined as: 

ὕὅὙ
„ᴂ

„ ᴂ
 

„ᴂ is taken from Preconsolidation_Stress_5 field 
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14.14.6 Preconsolidation Stress 6 and Overconsolidation Ratio 6 

The Preconsolidation Stress 6 („ᴂ) of all soil types in Preconsolidation_Stress_6 is defined as: 

„  ὅϽ„ ϽὋϽρπ Ͻ„ ᴂ 

Mayne (2007), NCHRP Synthesis 368 pp 37 

Where: 

ὅ is 0.101 in the published formula, and is stored in the Preconsolidation_Stress_6_C1 field 

ὅ is 0.102 in the published formula, and is stored in the Preconsolidation_Stress_6_C2 field 

ὅ is 0.478 in the published formula, and is stored in the Preconsolidation_Stress_6_C3 field 

ὅ is 0.420 in the published formula, and is stored in the Preconsolidation_Stress_6_C4 field 

Ὃ is taken from Small_Strain_Shear_Modulus_2 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

The overconsolidation ratio 6 in Overconsolidation_Ratio_6 is defined as: 

ὕὅὙ
„ᴂ

„ ᴂ
 

„ᴂ is taken from Preconsolidation_Stress_6 field 

14.15 Effective Angle of Friction  

14.15.1 Effective Angle of Friction 1 

The effective angle of internal friction of mixed soils (‰) in Effective_Friction_Angle_1 is defined as: 

‰  ὅЈϽὄ Ͻὅ ὅϽὄ  ÌÏÇὗ   

Mayne and Campanella (2005), NCHRP Synthesis 368 pp 38-39 

Where: 

ὅ is 29.5 in the published formula, and is stored in the Effective_Friction_Angle_1_C1 field. 

ὅ is 0.121 in the published formula, and is stored in the Effective_Friction_Angle_1_C2 field. 

ὅ is 0.256 in the published formula, and is stored in the Effective_Friction_Angle_1_C3 field. 

ὅ is 0.336 in the published formula, and is stored in the Effective_Friction_Angle_1_C4 field. 

This correlation of ‰ is only applicable for πȢρ  ὄ ρȢπ and hence will only be calculated if ὄ in the 

Pore_Pressure_Ratio field on the same row lies within this range.  

14.15.2 Effective Angle of Friction 2 

The effective angle of internal friction of sands (‰) in Effective_Friction_Angle_2 is defined as: 
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‰   ÔÁÎὅ ὅ Ͻ ÌÏÇ
Ͻ

 

Robertson and Campanella (1983), NCHRP Synthesis 368 p 38 

Where: 

ὅ is 0.1 in the published formula, and is stored in the Effective_Friction_Angle_2_C1 field. 

ὅ is 0.38 in the published formula, and is stored in the Effective_Friction_Angle_2_C2 field. 

This correlation of ‰ is only applicable for Sands and hence will only be calculated if the Soil_Type_1 
field value is coarse or mixed.  

14.15.3 Effective Angle of Friction 3 

The effective angle of internal friction of sand (‰) in Effective_Friction_Angle_3 is defined as: 

‰   ὅ  ὅϽÌÏÇή  

Kulhawy and Mayne (1990), NCHRP Synthesis 368 p 38 

Where: 

ὅ is 17.6° in the published formula, and is stored in the Effective_Friction_Angle_3_C1 field. 

ὅ is 11.0° in the published formula, and is stored in the Effective_Friction_Angle_3_C2 field. 

This correlation of ‰ is only applicable for Sands and hence will only be calculated if the Soil_Type_1 
field value is coarse or mixed.  

14.16 Effective Cohesion  

14.16.1 Effective Cohesion 1 

The cohesion (ὧ) in Effective_Cohesion_1 is defined as: 

ὧ  ὅ Ͻ„ᴂ 

Mayne and Stewart (1988), Mesri and Abdel-Ghaffar (1993), NCHRP Synthesis 368 p 44 

Where: 

ὅ is 0.02 in the published formula, and is stored in the Effective_Cohesion_1_C1_C1 field. 

„ᴂ is taken from Preconsolidation_Stress_1field. 

14.17 Sensitivity 

14.17.1 Sensitivity 1 

The Sensitivity (Ὓ) in Sensitivity_1 is defined as: 

Ὓ
ὔ

Ὑ
 

Schmertmann (1978b), Rad and Lunne (1986), CPT in Geotechnical Practice p 68 
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Where: 

ὔ is a value between 5 and 10 in the published formula, and is stored in the Sensitivity_1_Ns field. 

The constant is stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.17.2 Sensitivity 2 

The Sensitivity Ὓ in Sensitivity_2 is defined as: 

Ὓ
ὅϽήϽρπ  „

Ὢ
 

Mayne (2007), NCHRP Synthesis 368 p 41 

Where: 

ὅ is 0.073 in the published formula, and is stored in the Sensitivity_2_C1 field. 

The constant is stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation of Ὓ is based on the assumption of OCR < 2, ί πȢςς „ᴂ and „ᴂ πȢσσ ή „ . 

The value of Ὓ is recorded in the Sensitivity_2 field on the CPT_DATA table. 

14.18 Coefficient of Lateral Earth Pressure 

14.18.1 Coefficient of Lateral Earth Pressure 1 

Coefficient of Lateral Earth Pressure 1 (ὑ) is recorded in the Coefficient_Lateral_Earth_Pressure_1 is defined 
as: 

 

ὑ  ρ ÓÉÎ‰ᴂϽὕὅὙ  

ὓὥὼὭάόά ὑ  ὑ  
ρ ÓÉÎ‰ᴂ

ρ ÓÉÎ‰ᴂ
 

Mayne (2007), NCHRP Synthesis 368 p 42 

Where: 

ὕὅὙ is taken from the Overconsolidation_Ratio_1 for fine material and the Overconsolidation_Ratio_5 for 
coarse material, fields on the CPT_DATA table.  

‰ is taken from the Effective_Friction_Angle_3 and Effective_Friction_Angle_1 field on the CPT_DATA 
table.  

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.18.2 Coefficient of Lateral Earth Pressure 2 

Coefficient of Lateral Earth Pressure 2 (ὑ) is recorded in the Coefficient_Lateral_Earth_Pressure_2 is defined 
as: 
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ὑ  ὅϽ
ήϽρπ

„
Ͻ
„

„ ᴂ
ϽὕὅὙ 

Mayne (2007), NCHRP Synthesis 368 p 43 

Where: 

ὕὅὙ is taken from the Overconsolidation_Ratio_5 field on the CPT_DATA table.  

ὅ is 0.192 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_2_C1 
field. 

ὅ is 0.22 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_2_C2 field. 

ὅ is 0.31 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_2_C3 field. 

ὅ is 0.27 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_2_C3 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.18.3 Coefficient of Lateral Earth Pressure 3 

Coefficient of Lateral Earth Pressure 3 (ὑ) is recorded in the Coefficient_Lateral_Earth_Pressure_3 is defined 
as: 

 

ὑ  ὅϽ
ήϽρπ „

„ ᴂ
 

Kulhawy and Mayne (1990), CPT Guide p 32 

Where: 

ὅ is 0.1 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_3_C1 field. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

14.19 Rigidity Index 

14.19.1 Rigidity Index 1 

Rigidity index 1 (Ὅ) for fine material is recorded in the Rigidity_Index_1 is defined as: 

 

Ὅ Ὡὼὴ
ὅ

ὓ
 ὅ Ͻ

ήϽρπ ɀ „

ή Ͻρπ ɀ ό 
ɀ ὅ  

Mayne (2001), NCHRP Synthesis 368 p 46 

Where: 

ὅ is 1.5 in the published formula, and is stored in the Rigidity_Index_1_C1 field. 

ὅ is 2.925 in the published formula, and is stored in the Rigidity_Index_1_C2 field. 
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ὅ is 2.925 in the published formula, and is stored in the Rigidity_Index_1_C3 field. 

ὓ is the Cam clay constant, slope of the critical state line and is defined as: 

ὓ
φϽÓÉÎ‰

σ  ÓÉÎ‰
 

‰ for the calculation of the Cam clay constant ὓ is taken from the Effective_Friction_Angle_1 field 
on the CPT_DATA table.  

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation of Ὅ is calculated only when the Soil_Type_1 field value on the CPT_DATA table has a 
value of Fine for that row. 

14.19.2 Rigidity Index 2 

Rigidity index 2 (Ὅ) for fine material based on plasticity index and OCR is recorded in the Rigidity_Index_2 
is defined as: 

Ὅ
ὩὼὴὅϽὅ ὖὍ

ρ  ÌÎρ ὅϽὕὅὙρ
 

Keaveny and Mitchel (1986), NCHRP Synthesis 368 p 46 

Where: 

ὅ is 0.0435 in the published formula, and is stored in the Rigidity_Index_2_C1 field. 

ὅ is 137 in the published formula, and is stored in the Rigidity_Index_2_C2 field. 

ὅ is 0.385 in the published formula, and is stored in the Rigidity_Index_2_C3 field. 

ὅ is 3.2 in the published formula, and is stored in the Rigidity_Index_2_C4 field. 

ὅ is 0.8 in the published formula, and is stored in the Rigidity_Index_2_C5 field. 

ὖὍ is the Plasticity Index, and is stored in the Plasticity_Index field. 

ὕὅὙ is taken from the Overconsolidation_Ratio_4 field on the CPT_DATA table. 

The constants are stored on CPT_POINT_CORRELATION_PARAMETERS and 
CPT_PROJECT_CORRELATION_PARAMETERS tables. 

This correlation of Ὅ is calculated only when the Soil_Type_1 field value on the CPT_DATA table has a 
value of Fine for that row. 

14.20 Hydraulic Conductivity  

14.20.1 Hydraulic Conductivity 1 

The hydraulic conductivity (permeability) method 1 (K 1) in Hydraulic_Conductivity_1_Min and 
Hydraulic_Conductivity_1_Max are defined in the following table.  Soil Behaviour Type Robertson et al. 1986 
or Robertson et al. 1986 qc vs. Rf must be calculated for this correlation to be defined. 

Zone  Soil Behaviour  Type (SBT)  Range of hydraulic conductivity 
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(permeability)  K (m/s)  

1 Sensitive fine grained 3x10
-9

 to 3x10
-8

 

2 Organic soils 1x10
-8

 to 1x10
-6

 

3 Clay 1x10
-10

 to 1x10
-9

 

4 Silty clay to clay 1x10
-9

 to 1x10
-8

 

5 Clayey silt to silty clay 1x10
-8

 to 1x10
-7

 

6 Sandy silt to clayey silt 1x10
-7

 to 1x10
-6

 

7 Silty sand to sandy silt 1x10
-5

 to 1x10
-6

 

8 Sand to silty sand 1x10
-5

 to 1x10
-4

 

9 Sand 1x10
-4

 to 1x10
-3

 

10 Gravelly sand to dense sand 1x10
-3

 to 1 

11 Very stiff fine-grained soil 1x10
-8

 to 1x10
-6

 

12 Very stiff sand to clayey sand 3x10
-7

 to 3x10
-4

 

Robertson (2009), pp41, Table 6 

14.20.2 Hydraulic Conductivity 2  

The hydraulic conductivity (permeability) method 2 (K 2) in Hydraulic_Conductivity_2_Min and 
Hydraulic_Conductivity_2_Max are defined in the following table.  Soil Behaviour Type Robertson 1990 or 
Robertson 1990 Extrapolated must be calculated for this correlation to be defined. 

Zone Soil Behaviour Type (SBTN)  Range of hydraulic conductivity 
(permeability) k (m/s)  

1 Sensitive fine grained  3x10
-9

 to 3x10
-8

 

2 Organic soils 1x10
-8

 to 1x10
-6

 

3 Clay 1x10
-10

 to 1x10
-9

 

4 Silt mixtures 3x10
-9

 to 1x10
-7

 

5 Sand mixtures 1x10
-7

 to 1x10
-5

 

6 Sands 1x10
-5

 to 1x10
-3

 

7 Gravelly sands to dense sands 1x10
-3

 to 1 

8 Very stiff sand to clayey sand  1x10
-8

 to 1x10
-6

 

9 Very stiff fine-grained soil 1x10
-8

 to 1x10
-6

 

Robertson (2009), pp41, Table 7 
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15 Creating a New Soil Behaviour Type  
Creating a new soil behaviour type involves adding data to library tables, and creating Graph reports.  
As an example we will add a new SBT method titled GEO. 

1. Create the points and a graph for the new method in Excel.   

¶ Ensure there are no gaps and points of neighbouring zones coincide 

¶ The polygons must be closed, i.e. the first point is the same as the last point 

¶ It doesnôt matter if the lines progress clockwise or anti-clockwise 
 

 

2. DG_CPT_SOIL_CLASS_METHOD 

 

Graph 2 is optional 












































































































































































































